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1 Introduction

EagleFiler makes managing your information easy. It lets you archive and search mail, Web pages,
PDF files, word processing documents, images, and more. Use it to collect information from a
variety of sources. Create new documents right from the toolbar. Browse different types of files
using a standard three-pane interface. Organize them into folders and annotate them with tags
and notes, or leave everything in one folder and pin-point the information you need using the live
search. Since EagleFiler stores its library in Finder format, you can use it in concert with the other
tools in your Mac ecosystem.

EagleFiler in a nutshell:

1. With a single keypress, import Web pages, mail messages, or any file on your Mac.

2. EagleFiler stores them in an open format: regular files and folders that are fully acces-
sible to your other applications.

3. Optionally: encrypt the files, add tags, notes, color-coded labels, and other metadata.

4. Browse by folder or by tag, or use the live search to find the information you need
(faster than Spotlight).

5. View, edit, or create documents directly in EagleFiler’s streamlined interface, or double-
click to edit using another application.

1.1 Importing Is a Snap

Getting your information into EagleFiler is easy. When you're viewing a Web page in Safari or
NetNewsWire!, looking at a mailbox in Mail, or browsing files in the Finder, just press the capture
key (F1 by default, or Option-F1 to see the options below). EagleFiler will save the document
into its library, and you can go right on working without interrupting your flow. (Of course, you
can also use drag and drop or other methods if you prefer.) Once the document is in EagleFiler,
you’ll always have a copy of the way it looked when you imported it. No more bookmarking a
great article, only to find out later that the page is no longer available or that registration or even
payment is now required. If you do research on the Web, you know that pages change—sometimes
without notice—so it’s always good to keep a paper trail of exactly what you read. There’s no
shame in being a digital pack rat when today’s Macs ship with tens or even hundreds of gigabytes
of storage.

"http://ranchero.com/netnewswire/
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Source: http://www.apple.com/iphone/specs.html

Destination: | /%) Sample Library b3 | [ iPhone =

Title:  Automatic

From: | Automatic

Label: [ @B Red B

Tags: unread apple iphone
imac

iphone i
Notes: Use noles to record your =

thoughis about the document you're capturing or about what
you need 1o do with it. Noles can include lists, tables, and
images, as well as ditfferent fors and slies.

(_Cancel ) ((Capture’)

i

1.2 Familiar Mail-like Interface

EagleFiler browser windows use a three-pane view that’s familiar to any Mail user. This is not a
database front-end; it’s a real Mac application with a fully Aqua user interface. Click on one or
more sources to view their contents. Enter some text in the search box to filter the record list.
Click on a record to view it right there in the window. HTML mail messages can be viewed as rich
text, or you can view e-mails as plain text, complete with color-coded quoted text and clickable
links. You can open as many windows as you want to view different parts of the library.

1.3 Search Everything

It’s no good to store your information if you can’t find it when you need it. Fortunately, EagleFiler
offers some powerful search options. If you know the title, author, or recipient you're looking for,
you can search by one of those fields. Or, use EagleFiler’s indexed search to look through the
entire contents of your documents. Like Spotlight, EagleFiler can search different types of files at
once—after all, what matters is what you’re looking for, not whether it’s in a PDF, an e-mail, or
a chat.
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B

Unlike Spotlight, EagleFiler makes it easy to narrow down the results. You’re searching within
the library, not all the files on your hard disk, so the search is fast. You can select one or more
folders or mailboxes within the library to restrict the search—reducing the amount of data that
EagleFiler has to look through, and number of results that you’ll have to comb through. You can
even do Boolean, tag, and phrase-based searches to tell EagleFiler exactly what you’re looking
for. Once you’ve narrowed the search results to a manageable number of documents, it’s easy to
find the information you’re looking for because you can view the document contents right there in

EagleFiler.

For more complex searches, or for quick access to your most common searches, you can create your

own smart folders.

1.4 The Library Is Open

Like iTunes and iPhoto, EagleFiler keeps your data in a library. The library is just a special folder
in the Finder that EagleFiler manages. You shouldn’t re-arrange the files and folders in the library
except through EagleFiler, but other than that you can treat it just like a regular folder. Browse



its contents in the Finder or Path Finder?—the folder structure matches the folders in EagleFiler.

Kind I
v [ Files Folder
| 2 ﬁ Mews Folder
| 4 ﬁ'ﬂ Programming Folder
» [] Publications Folder
» [l Trash Folder
| 4 E Motes Folder
@ Sample Library.eflibrary EagleFiler Library
| 2 E Smart Folders Folder
| 2 ﬁ To Import (Sample Library) Folder
A

View and edit the files using your favorite applications. Drag key files to the Dock or make aliases
of them on your desktop. Search the files using Spotlight. Back them up using Time Machine.
Label files in EagleFiler, and the labels automatically show up in the Finder—and vice-versa. Files
in the library will still show up in your application’s Open Recent menus, and Preview will still
remember which page of the PDF you were reading. In short, you can capture, organize, and search
your files using EagleFiler, without giving up the normal conveniences of the Mac experience.

1.5 Reliable Data Storage

The library may look like just a folder full of files, but EagleFiler uses a Core Data® SQL database
to keep track of the files and their contents. This lets you put thousands of files in the library and
access them reliably and quickly. Each time you open a library, EagleFiler checks to make sure
that all the files are present. It can even verify the library (using MD5 checksums?) to make sure
that none of the files has been corrupted. There’s no point in storing and backing up damaged
files. When you archive your documents in EagleFiler, you can be sure that when you need to read
them again they’ll be in pristine condition.

“http://www.cocoatech.com
3http://developer.apple.com/macosx/coredata.html
‘http://en.wikipedia.org/wiki/Md5#Applications
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196 of 531 — About 3 minutes

Sample Library: Verifying data integrity

About 5 seconds

Plus, EagleFiler libraries go great with backups and archival. Your data is stored in individual files,
so smart backup and synchronization programs won’t waste time and space copying the documents
that haven’t changed. Since the files are in standard formats like PDF, RTF, and mbox, you’ll be
able to read them years from now, even if—alas—you’re no longer using EagleFiler.

1.6 Add Tags and Notes

Tags are somewhat like labels in the Finder, except that each record can have as many tags as
you want. EagleFiler has some tags such as “unread,” “flagged,” and “replied” built-in, and it will
import these from Mail. If you've created additional tags in Mail using MailTags®, EagleFiler will
import those as well. You can also create your own tags. Tags may be treated like keywords, and
each tag also appears as a source in the browser window, which acts like a playlist in iTunes or an
album in iPhoto.

Tags: note rebate waiting

MNotes:

- Amazon product page (live link)
- Drder confirmation (Web archive in EF]|

*http://www.indev.ca/MailTags.html
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Each document or message in EagleFiler can also have a note. Notes, which you can edit in
EagleFiler’s Info inspector, are like comments in the Finder on steroids. They support rich text
with multiple fonts, sizes, and colors. Notes can even include clickable links, graphics, tables, and
lists. Use notes to write down information that goes with your documents, to excerpt key passages,
to add your own comments or analysis, or to add links to related records in EagleFiler.

1.7 Speed Up and Simplify Your Other Applications

Most e-mail programs are designed for communicating with your mail server and letting you read
and write messages—not for storing all your old mail. By cleaning out your mail program’s
database, you can remove some clutter from its mailbox list and speed it up. EagleFiler pre-
serves the entire message source, including headers and attachments. But cleaning it out doesn’t
have to mean lots of time wasted trying to predict which messages you might need in the future.
Disk space is plentiful—just archive all your old mail into EagleFiler. Later, you’ll be able to find
what you need with a quick search. Meanwhile, the archived messages will no longer be slowing
down Spotlight searches of your files and current messages.

Likewise, your Web browser’s bookmarks feature is great for remembering sites that you’ll want
to go back to frequently. But it isn’t ideal for remembering the information found on Web pages.
Don’t bookmark news articles, recipes, reviews, and other documents—and then try to look through
your overflowing bookmarks folder to recall the articles by title and URL. Instead, capture the Web
pages into EagleFiler where you’ll be able to search their entire contents.

1.8 Multiple Libraries

Some people like to dump all their information into a single EagleFiler library, with minimal folder
structure, and locate documents that they need using the search feature. But EagleFiler also
supports multiple libraries, for those who like to separate their business and personal files, group
them by project or client, or keep different kinds of files in different places. For example, you might
keep some of your files on your iPod or USB keychain drive, some in an encrypted library, and
others in your Documents folder. Unlike with iPhoto and iTunes, you can have multiple EagleFiler
libraries open at once. However you want to group your files, EagleFiler can accommodate.

1.9 Feature List

The following is a partial list of EagleFiler’s features, so that you can quickly see how it works and
how it’s unique:

General

e Easy to install: just drag and drop a single application file. There’s no need to install a
database engine, plug-ins, or script files to integrate with your other applications.

10



Easy to use, with a familiar three-pane interface—lots of power, without lots of cluttered
options.

Makes efficient use of RAM and disk space.

AppleScript support, for automation and integration with other applications.

Importing

Mail

Can import any kind of file. EagleFiler has special support for displaying most common
formats, and it can use Quick Look to display the others.

Just press a hotkey while in another application, and EagleFiler will intelligently import
the Web page, mailbox, or file that you’re currently viewing.

Supported Web page formats: bookmark, PDF, plain text, rich text, rich text with
images, Web archive.

Import from any application by printing and choosing Save PDF to EagleFiler or by
saving a file into EagleFiler’s To Import folder.

Import Web pages using bookmarkletsS.

Automatically import scans by setting your scanner software (Fujitsu ScanSnap” recom-
mended) to save its files in the To Import folder.

There are many other ways to import (e.g. drag and drop, services) so you can choose
whatever’s easiest for the task at hand.

Automatically detects duplicate files to save disk space and help you see what’s already
been imported.

First-class support for archiving e-mail. EagleFiler understands the content of messages
and treats them as mail rather than as text or RTF files.

Import the selected mailboxes or messages simply by pressing a hotkey.

EagleFiler retains the full message data, including attachments, read/flagged/replied
status, and MailTags®, so nothing is lost when moving mail into EagleFiler.

Speed up your mail program by moving older messages to EagleFiler.

Messages are efficiently stored using the standard “mbox” format and can be imported
back into any mail program if desired.

Can display messages as plain text (with colored quote levels and clickable links) or as
HTML.

Organization

EagleFiler supports multiple libraries, stored wherever you want (hard disk, iDisk,
iPhone, iPod, USB drive, etc.).

Shttp://c-command. com/eaglefiler/bookmarklets
"http://www.fujitsu.com/us/services/computing/peripherals/scanners/scansnap/s510m.html
Shttp://www.indev.ca/MailTags.html
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You can open more than one library at a time, and more than one window per library.

Files can be organized with folders and tags, both of which can be nested.

Editing

e Create a new file with a single button or keypress and immediately begin typing. There’s
no need to open a new window or go through a Save dialog box.

e Use stationery (a.k.a. templates) to quickly create any type of new file.

e RTF, text, and OpenDocument files can be edited from within EagleFiler.

e For other types of files (e.g. Word, Pages), just double-click to open them in your favorite
editor. The changes are automatically saved back into the EagleFiler library.

Storage

e Your data and notes are stored in regular files using standard formats (RTF, PDF, Web
archive, mbox, etc.), so there’s no lock-in or risk of database corruption, and it plays
well with Time Machine?.

e Uses MD5 checksums to verify the integrity of all files in the library.

e Metadata (tags, titles, source URLs, etc.) goes into a Core Data!® SQL database for
reliable storage and quick access.

e EagleFiler automatically backs up the metadata and notes to XML property list files. In
the rare event that the database file becomes damaged, you can import the files into a
new library, and EagleFiler will build a new database and reconstruct all the metadata.

e Can copy tags into the Spotlight comments field to make them searchable and accessible
to other applications.

Encryption

e Libraries can be encrypted with AES-128 or AES-256'! for secure, password-protected
storage.

e Encrypted libraries are stored using Apple’s disk image technology, so their contents are
accessible on any Mac, whether or not EagleFiler is installed.

e The entire library contents—including the metadata, indexes, and temporary files—are
encrypted. Unencrypted data never touches the disk.

e In other respects, an encrypted library works just like a regular one. It’s still fully
searchable, and the files are still accessible to other applications (once you've entered
the passphrase).

Search

EagleFiler uses its own optimized indexes so that you can search the contents of your
library faster than with Spotlight.

“http://www.apple.com/macosx/features/timemachine . html
Ohttp://developer.apple.com/macosx/coredata.html
Yhttp://en.wikipedia.org/wiki/Advanced Encryption_Standard#Security_of AES
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e You can do exact searches across individual fields (title, filename, notes, tags, from,
to/cc) as well as searches across the entire file contents.

e Searches can use phrases, wildcards, Boolean AND/OR/NOT, and grouping.

e Create your own smart folders and organize them into folders. Custom smart folders
can contain an unlimited number of criteria, optionally using nested Any/All/None. You
can define actions to occur when you drag a record onto a smart folder.

e Matching search terms are highlighted in the document contents and in the records list.
Use the Find panel to search within a document.

e EagleFiler reads most files itself, so it can index text that Spotlight wouldn’t see (e.g.
Skim'2? notes attached to PDF files). It automatically takes advantage of third-party
Spotlight importer plug-ins to support custom file formats.

e Since the files and notes are stored out in the open, they’re also searchable with Spotlight
(for when you want to search your entire Mac at once), without the need for stub files
in the Caches/Metadata folder.

Metadata

e For each file, EagleFiler records the document title, author/from, and source URL.

e You can assign tags (a.k.a. keywords). Tags can have abbreviation symbols and colors,
and they can be nested. Quickly assign tags by typing (with auto-completion), drag-
and-drop, or by clicking on them in the Tag Cloud.

e Each file or mail message can have notes, which can include rich text, clickable links,
images, and tables.

e Each file can have a colored label, which also shows up in the Finder.

e You can copy links to EagleFiler records and paste them into notes or RTF files, or into
other applications.

e When importing via the capture key, EagleFiler can preserve metadata (e.g. tags, notes,
titles, URLs) from the source application. This is often higher fidelity than using that
application’s own export feature.

e When importing an existing file, EagleFiler can import tags and notes from the file’s
Spotlight comments.

2 Installing and Updating

2.1 Requirements

EagleFiler is a universal binary that runs natively on both PowerPC- and Intel-based Macs using
Mac OS X 10.4-10.5.

2http://skim-app.sourceforge.net
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It is also recommended that you install Growl]'3

is imported into EagleFiler.

so that you get a notification each time a document

2.2 Updating From a Previous Version

The easiest way to update EagleFiler is to use the Software Update command to download and
install the latest version.

Alternatively, you can replace the old EagleFiler application file with the new one. That is, if
FagleFiler is installed in the Applications folder, drag the new EagleFiler application icon into
the Applications folder and click Replace when the Finder asks if you want to overwrite the old
version. If you get an error saying that you do not have sufficient privileges, drag the old EagleFiler
to the trash and empty it, and then drag the new one into the Applications folder.

2.3 Installing EagleFiler

Double-click the EagleFiler-1.4.dmg file to mount the EagleFiler disk image. Then drag the
EagleFiler application to your Applications folder. You may need to log out and then log in
again in order for the EagleFiler: Import command to appear in the Services menu.

2.4 Uninstalling EagleFiler

To uninstall EagleFiler, drag its application file to the trash. Although you will no longer be able
to open your libraries with EagleFiler, the files in the libraries will remain accessible in the Finder.
Next to each library is a folder called Files (which contains the files and folders in the library)
and a folder called Notes (which contains any notes that you've added).

3 Using EagleFiler

3.1 Basics

Within EagleFiler, you work with one or more libraries. Each library that’s open in EagleFiler is
displayed in one or more browser windows. Each browser window contains a source list, which lets
you access the library’s records. The record is the basic unit of information in EagleFiler. Files,
folders, and mail messages are all records. Each record has contents that can be displayed (and
perhaps edited) in the record viewer, and you can annotate records with tags and notes.

Bhttp://growl.info
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To start using EagleFiler, you need to create a New Library.... Then you can add records to your
library. You can create new documents from within EagleFiler using the New Record > Rich Text
File command for the New RTF toolbar button. You can also import existing files and Web pages
into your library. There are many different ways to import.

EagleFiler libraries are like iPhoto libraries: when you import a file, a copy is created in the library.
While EagleFiler is importing, it shows:

e a downward-pointing green arrow in EagleFiler’s Dock tile.

e a spinning progress indicator below the source list for the libraries that are being imported
into.

e an entry in the Activity window.

You should not modify or delete a file or mailbox while EagleFiler is in the midst of importing it.
Doing so could cause EagleFiler to copy the file in an inconsistent state. Once the import is done,
you will have a copy in the library and you can modify or delete the original if desired.

3.2 Library Folders

Outside of EagleFiler, for example when you are browsing in the Finder, each EagleFiler library
appears as a library folder with the following structure:
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Kind i
v [ Files Folder
| E Mews Folder
| 2 ﬁ‘ Programming Folder
» | ] Publications Folder
» [l Trash Folder
| 2 E Motes Folder
@ Sample Library.eflibrary EagleFiler Library
| 4 E Smart Folders Folder
| m To Import (Sample Library) Folder
s

The .eflibrary file is the way that you open the library in EagleFiler. It also holds var-
ious information about the contents of the library, such as indexes that EagleFiler uses for
searching, as well as tags and other metadata that you've added.

The Files folder contains all the files and folders that have been imported into the library.
The folder hierarchy within the Files folder matches that within EagleFiler, so you can easily
browse and search the contents of your library from outside of EagleFiler.

The Notes folder contains one RTF file for each record that has a note. You can edit a
record’s notes using the Info inspector. The notes are searchable within EagleFiler and also
from Spotlight.

One way to import files into the library is to move or save them into To Import folder.
You can do this even if EagleFiler is not currently running. When EagleFiler completes the
import, the files are in the Files folder and no longer appear in the To Import folder.

If a file in the To Import folder cannot be imported, EagleFiler moves it to the Unable to
Import folder. If there have not been any such errors, this folder will not exist.

The Smart Folders folder contains a .plist file for each smart folder in the library. You
can copy a smart folder from one library to another by copying the associated .plist file.
(Make sure that the libraries aren’t open in EagleFiler when you do this.)

The contents of the library folder are managed by EagleFiler. What this means is that the files and
folders are fully accessible to other applications, but there are some limits to the kinds of changes
you can make to the library from outside of EagleFiler.

You can:
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e view and search the contents of the library folder using the Finder, Spotlight, and other
applications.

e open files using other applications.
e edit files using other applications and save your changes (without changing the filename).
e add files to the To Import folder.

e change the Finder label, Spotlight comments, and extended attributes of files in the library
folder.

e store the library folder on a shared volume.
So long as you don’t do it while the library is open in EagleFiler, you can:

e move or rename the library folder.
e move or rename the .eflibrary file.

e backup and restore the entire library folder.
You should not:

e open the library in more than one copy of EagleFiler at a time.
e move, rename, or delete files inside the Files or Notes folders.
e modify the .eflibrary file.

e edit the contents of mailbox files.

e store a library inside another library’s folder.

These three restrictions ensure that the contents of the library folder stay in sync with the .eflibrary,
so that EagleFiler knows where all the files are. If necessary, you can create new files inside the
Files or Notes folders, but in most situations this is not very useful because EagleFiler will ignore
files that were neither created in EagleFiler nor imported.

A common question is about file synchronization software:

e It’s fine to use software that copies folders quickly by only copying the files that have changed.
An example of this is SuperDuper’s'* Smart Update feature. Such software works great with
EagleFiler because it copies data in only one direction at a time. You end up with the same
result as if you’d done a regular copy, but it doesn’t take as long. If you use ChronoSync, be
sure to uncheck Prune folders and Ignore invisibles.

“pttp://www.shirt-pocket . com/SuperDuper/SuperDuperDescription. html
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e You should not use software that synchronizes or merges by copying data in both directions
at once. This is equivalent to adding/moving/renaming/deleting files, and so it would cause
the Files and Notes folders to get out of sync with the .eflibrary file.

3.3 Ways to Import

There are many ways to get your files into EagleFiler. In most cases, the easiest way is to press
the capture key or the capture with options key. EagleFiler will automatically determine what
you have selected or what you’re viewing in the current application, and it will import it into the
library. For example, if you're looking at a Web page in Safari, you can press the capture key to
import it as a Web archive. Press the capture with options key if you want to import it and, at
the same time, assign tags or choose which folder it will go into.

Although the capture key is quick and easy, depending on the circumstances you may prefer to:

e Drag files, text, or a URL onto:

— An EagleFiler browser window’s source list or records list. This can be useful if you
want to import into a particular folder or tag source that you're currently viewing.

— The Drop Pad. The capture key is for importing whole documents. If you just want to
import a selection of text, it’s better to drag and drop onto the Drop Pad or EagleFiler’s
icon, or to use the service (see below).

— The EagleFiler application icon (in the Finder or in the Dock).

e Select some items or text in another application and choose EagleFiler: Import from the
Services menu (inside application menu) or press Command%. You may have to log out and
log in again after installing EagleFiler in order for it to appear in the Services menu. You
can change the keyboard shortcut using the Keyboard pane in System Preferences.

e While viewing a document in another application, choose File > Print and then choose Save
PDF to EagleFiler from the PDF button menu. This will convert the document to PDF
format and import it into EagleFiler. As with the To Import folder (see below) this can be
useful when you’re viewing a Web page (such as an Amazon order confirmation page) that
cannot be imported by URL.

e Save files or folders into the To Import folder that’s next to the .eflibrary file in the Finder.
When the library is opened (and, periodically, while it’s open) EagleFiler checks this folder,
imports any files that are in it, and then deletes them.

— If you use a scanner, you can set its software to use the To Import folder as its output
folder, thus automatically importing the scans into your library.

— You can put To Import folder(s) in the sidebar in the Finder so that they’re available
in every application’s Save panel.
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e Click on one of the EagleFiler bookmarklets'® in your Web browser.
e Choose Import File(s). .. from the File menu.
e Choose Import URL(s). .. from the File menu.

e Drag files from one EagleFiler library window to another. This will preserve all of the tags,
notes, and other metadata.

e Put some text on the clipboard using Edit > Copy and then choose Import Clipboard
from EagleFiler’s Dock menu.

e Control-click on a file in the Finder and choose Open With > EagleFiler.

e Install some AppleScript files so that you can import directly from LaunchBar'® or Quicksil-
17
vert’,

e Run an AppleScript such as:

tell application "EagleFiler"

import files {POSIX file "/Users/mjt/Desktop/MyFile"}

import URLs {"http://www.apple.com", "http://c-command.com"}
end tell

In all cases, the data is copied into the EagleFiler library (as with iPhoto). EagleFiler automatically
detects duplicate files so that only one copy of each document is stored in the library.

If more than one library is open (and you didn’t drag into a specific browser window), EagleFiler
assumes that you meant to import into the current library (the one with the frontmost window).
If no library is open, EagleFiler will show a dialog asking you to open one; then you can click the
Import button to import the files into that library.

For advice about how to import e-mail messages, see the Importing Mail section.

3.4 What Can Be Imported

EagleFiler can import virtually any file on your Mac, as well as Web pages that are displayed in your
browser and e-mail messages that are displayed in your mail program. EagleFiler has specialized
importing and viewing support for the following types of files:

e Bean!® documents.

e Bookmark (.webloc) files and bookmarks dragged from Safari'® and OmniWeb?°.

Yhttp://c-command.com/eaglefiler/bookmarklets
http://c-command. com/scripts/eaglefiler/launchbar-import-text
"http://c-command.com/scripts/eaglefiler/quicksilver-import-text
Bhttp://www.bean-osx.com
Yhttp://www.apple.com/macosx/features/safari/
2Onttp://www.omnigroup.com/applications/omniweb/
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e Chat transcripts from iChat?! and Adium??.

e Dragged text from other applications. In some cases, EagleFiler will be able to import more
information if you drag the text onto one of its windows rather than its Dock icon. For
example, when dragging text from Safari, EagleFiler will be able to store URL that goes with
the text.

e Folders. EagleFiler imports the contents of the folder (and any subfolders, preserving the
hierarchy).

e HTML files.
e iCalendar (.ics) files.
e Images.

e Mailboxes in mbox format and Apple Mail mailboxes, attachments included. The Import-
ing Mail section explains the recommended ways to import mail messages from each e-mail
program.

e Mail messages, stored as .eml files.
e Microsoft Word files.

e Movies.

e OpenDocument Text files.

e PDF files. EagleFiler also understands PDFD bundles created by Skim?? and can index Skim
notes that are attached to PDF or PDFD files.

e PostScript and EPS files.

e Property list files (XML and binary).

e Rich Text (RTF and RTFD) files.

e Sounds and music.

e Text files (encoded with ASCII or UTF-8, or with a byte-order-mark) and text clippings.
e URLs, which will be downloaded and converted to Web archives.

e vCard (.vcf) files from Address Book.

e Web archives.

Documents that aren’t of any of the above types can also be imported into EagleFiler. EagleFiler
can preview their contents using Quick Look, and it uses Spotlight’s importers to index them for
searching. You can use the Open With External Viewer command to open the documents in other
applications.

2http://www.apple.com/macosx/features/ichat/
“nttp://www.adiumx. com
Znttp://skim-app.sourceforge.net
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3.5 Importing Mail

Importing mail into EagleFiler speeds up your mail program and backups, creates an efficient and
secure archive of your mail, and lets you organize and search mail messages alongside related files.
The recommended way to import mail varies depending on which mail program you’re using:

Apple Mail

Select some mailboxes or messages and press the capture key. EagleFiler will pre-
serve the message status and flagged indicators from Mail, as well as any keywords,
projects, and notes from MailTags?4. EagleFiler is able to import messages from
IMAP mailboxes, however it will only import the parts of the messages that have
been downloaded from the server. Thus, it is recommended that you select the
option in Mail’s preferences to keep All messages and their attachments for
offline viewing. Another way to import from Apple Mail is to drag and drop folders
or mailboxes from the Finder. This makes it possible to import whole hierarchies
of mail.

Entourage
Select a mailbox or some messages and press the capture key. EagleFiler will

preserve the message flags, categories, and projects. EagleFiler skips messages
that have been assigned the “OmitFromArchive” category in Entourage.

Eudora
Mailboxes are stored in the Mail Folder folder inside the Eudora Folder folder,
and they can be dragged from the Finder into EagleFiler. They are not actually in
mbox format (for example, the attachments are removed), but the format is close
enough that EagleFiler will be able to read most of the messages. Running the
mailboxes through Eudora Mailbox Cleaner? before importing them into Eagle-
Filer may produce better results. The .toc files are not mailboxes and should not
be imported.

GyazMail
Select some mailboxes and choose File > Export > Unix mbox.... Then drag
the exported files into EagleFiler.

Mailsmith
Select some mailboxes or messages and press the capture key. EagleFiler will
preserve the message status, label, and notes. You may find it helpful to use Email
Archiver?S to separate messages by age before importing them into EagleFiler. In
Mailsmith 2.1.5, dragging mailboxes directly to EagleFiler will not work, but you
can drag mailboxes to the Finder and then drag the exported files into EagleFiler.

PowerMail

Select some folders or messages and press the capture key. EagleFiler will preserve
the message status and label.

http://www.indev.ca/MailTags . html
2http://homepage .mac. com/aamann/Eudora_Mailbox_Cleaner.html
2nttp://www.garrison. com.au/freeware/emailarchiver.html
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Thunderbird
Before importing into EagleFiler, use Thunderbird’s Compact Folders command.
The mailboxes are stored in the folder:

/Users/<username>/Library/Thunderbird/Profiles/<profile>/Mail/Local Folders/

and can be dragged from the Finder to EagleFiler. The .msf files are not mailboxes
and be ignored or deleted from EagleFiler’s library.
Webmail

Web-based mail services do not store mail files on disk, so there is nothing for
EagleFiler to read. The best way to import Webmail is to connect to the mail
account using one of the above mail programs. If your Webmail does not support
this, you can drag and drop text from your Web browser, use File > Save to save
messages into EagleFiler’s To Import folder, or print and choose Save PDF to
EagleFiler.

When importing mail:

1. EagleFiler imports the entire raw source of the message, including the attachments and
headers. In other words, all the information is preserved; if desired, the messages can be
imported back into the mail program with full fidelity. (Exceptions: When importing
from Eudora, EagleFiler imports the message text as processed and stored by Eudora,
and it does not import the attachments, which Eudora stores separately. Webmail
messages imported as PDFs do not include the full source or attachments.)

2. As with other types of imports, EagleFiler copies the messages into its library. When
it’s done, you can delete the messages from your mail program. It’s simpler to have
each message stored in only one place (the mail program or EagleFiler), and this way
you won’t accidentally import multiple copies of the same messages into EagleFiler.

3. EagleFiler stores messages in mailbox (“mbox”) files. This is both for efficiency (one
file rather than thousands for a mailbox containing thousands of messages) and for
compatibility with other software that can read the standard mbox format.

4. Each time you import from a mailbox, a new mailbox file is created in EagleFiler, using
the same name as in your mail program. If you had previously imported from that
mailbox, you may already have a mailbox file in EagleFiler with that name.

e Some people like to leave each import as a separate mailbox, e.g. so that for each
mailbox there’s one file per month or per year.

e Others prefer to have a single file that holds all the messages imported from that
mailbox over time. To do this, select the Records source and sort by title. This
will group the related mailboxes together. You can then select the related mail-
boxes and use the Merge Mailboxes command to combine them into a single mail-
box. The combined mailbox will be stored in the folder that contained the oldest of
the selected mailboxes, so your organizational structure is preserved even though
the newly imported mailbox might have been imported at the top level.
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3.6 Applications That Support Capture

EagleFiler’s capture feature lets you import the current window or items from the frontmost ap-
plication, just by pressing a key. The capture key and capture with options key work in these
applications:

Address Book

Captures a vCard file for the selected contacts.

BBEdit
Captures the file of the first document of the front window.

Camino

Captures the URL of the current tab of the front window.

Cocoalicious
Captures the URLs of the selected posts, preserving the tags, description, and extended
description.

Cyndicate
Captures the URLs of the selected articles, preserving the label and flagged status.

DEVONagent
Captures the URL of the front browser window.

DEVONthink Pro

Captures the selected items, preserving the comments.

Endo
Captures the selected news items as Web archives, preserving their tags and importing the
excerpts as notes.

Entourage

Captures the selected messages or mailbox, preserving the message flags, categories, and
projects. If you want EagleFiler to skip a message, you can assign it the category “OmitFro-
mArchive”.

Finder

Captures the selected files in the front window.

Firefox

Captures the URL of the current tab. (For some users, Firefox 3 will report an error when
EagleFiler asks it for the URL. If this happens, you can import the page by dragging and
dropping the URL into EagleFiler.)

23


http://www.apple.com/support/leopard/addressbook/
http://www.barebones.com/products/bbedit/
http://www.caminobrowser.org
http://www.scifihifi.com/cocoalicious/
http://cynicalpeak.com/cyndicate/
http://www.devon-technologies.com/products/devonagent/index.html
http://www.devon-technologies.com/products/devonthink/index.html
http://kula.jp/software/endo/
http://www.microsoft.com/mac/products/entourage2008/default.mspx
http://www.apple.com/macosx/features/finder/
http://www.mozilla.com/en-US/firefox/

Flock

Captures the URL of the current tab.
iCab

Captures the URL of the front window.

Journler

Captures the selected documents, preserving their tags.

Keynote
Captures the file of the front window.

Mail

Captures the selected mailboxes or messages in the front viewer window. Tags, projects, and
annotations from MailTags?” are preserved.

Mailsmith

Captures the selected messages or mailboxes, preserving the message status, label, and notes.
You may find it helpful to use Email Archiver?® to separate messages by age before importing
them into EagleFiler.

MarsEdit

Captures the text of current post window or the selected posts, preserving the permalink and
the published date.

Microsoft Word (2004 and later)
Captures the file of the front window (make sure that it’s saved to disk).

MindManager
Captures the file of the front window.

Netflix Freak
Captures the URLSs of the selected movies.

NetNewsWire

Captures the URL of the current tab, or the URL of the selected headline (if no tab is
selected).

Nisus Writer Express

Captures the file of the front window.

OmniGraffle
Captures the file of the front window.

2"http://www.indev.ca/MailTags.html
2nttp://www.garrison. com.au/freeware/emailarchiver.html
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OmniWeb
Captures the URL of the current tab.

Opera
Captures the URL of the current tab.

Pages
Captures the file of the front window.

Path Finder

Captures the selected files in the front window.

PDFView
Captures the file of the front window.

PowerMail

Captures the selected messages or mailboxes, preserving the message status and label

Preview

Captures the frontmost document.

Pukka
Captures URL being added, along with the title, tags, and description.

Safari

Captures the URL of the current tab. Some Web pages (e.g. some sites that require logging
in) cannot be captured by loading the URL shown in Safari’s location bar. You can import
such pages into EagleFiler by using Safari’s File > Save As... command to save the page as
a Web archive (perhaps into the To Import folder of an EagleFiler library), or by choosing
File > Print and then selecting Save PDF to EagleFiler from the PDF button menu.

Skim
Captures the file of the front window.

SubEthaEdit
Captures the file of the front window.

TextEdit
Captures the file of the front window.

TextMate
Captures the file of the front window.

TextWrangler
Captures the file of the first document of the front window.
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Together

Captures the selected files, preserving the tags, comments, labels, and ratings.

Vienna

Captures the URL of the last selected post.

WebKit Nightly

See description for Safari.

WebnoteHappy
Captures the selected URLs as Web archives, preserving the tags and notes.

Yojimbo

Captures the selected items, preserving the tags, labels, and comments.

For applications that are not listed here, there are many other ways to import. For applications
that support AppleScript, you can add EagleFiler capture support by writing capture scripts.

3.7 Writing Capture Scripts

You can add support for capturing from additional applications by adding capture scripts to the
folder:

/Users/<username>/Library/Application Support/EagleFiler/Capture Scripts/

A capture script is an AppleScript saved in compiled format. The name of the file is of the form
<bundle identifier>.scpt, e.g. com.apple.Safari.scpt. You can determine an application’s
bundle identifier by finding the CFBundleIdentifier in the Info.plist file inside the application’s
package (which you can open using the Show Package Contents command when Control-clicking
on the application).

The script should have a handler called capture that returns a list of AppleScript records. For
example, the NetNewsWire capture script looks like:

on capture()
tell application "NetNewsWire"
set tabIndex to index of selected tab
if tabIndex is O then
if exists selectedHeadline then
set theURL to URL of selectedHeadline
else
return {{lerror|:"No URL is available to be captured."}}
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end if
else
set theURLs to URLs of tabs
set theURL to item (tabIndex + 1) of theURLs
end if
end tell
return {{|url|:theURL}}
end capture

Each record in the list should have a |url]| key (for a remote http URL) or a |path| key (for a
full POSIX path). If no items are available for capture, the script can return the empty list, or it
can return a record with a |error| key that provides an application-specific error message.

The capture script for the Finder demonstrates how to capture multiple items at once:

on capture()
tell application "Finder"
set theSelection to selection as list
set theResult to {}
repeat with theFile in theSelection
set theFile to theFile as alias
copy {lpath|:POSIX path of theFile} to end of theResult
end repeat
return theResult
end tell
end capture

Other, optional, keys are:

| deleteWhenDone |

If the script creates a temporary file for the capture, it can include this key with value true
so that EagleFiler will delete the temporary file after it has finished importing the file.

| fromName |

Overrides the From name that would be extracted from the file.

|notel

A string for the note text.

| sourceURL |

The URL that the document was downloaded from.

|tags|

A list of tag names.
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| tagsStringl

A Unicode string of space-separated tag names, which EagleFiler will parse.

[titlel
Overrides the title that would be extracted from the file.

| creationDate|

Sets the creation date of the file.

|modificationDate]

Sets the modification date of the file.

3.8 Shortcuts

Importing
F1
Capture Key.
Option-F1
Capture with options.

Command-%
Type this from another application to import the selected text or URL into EagleFiler.

Batch Change

Shift-Command-A
Append.

Shift-Command-R
Replace.

Command-3
Choose label.

Enter
OK.
Capture with options
Command-1
Choose library.

Command-2
Choose folder. Then you can select a folder by typing the first few letters of its name.

Command-3
Choose label.
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Command-K
Reset.

Enter
Capture.

Navigating browser windows

Command-Option-F
Make the search field active.

Command-Shift-T
Make the tag bar active.

Tab (in source list) or Control-Shift-Tab (in record viewer)
Make the records list active.

Tab (in records list) or Shift-Tab (in source list)
Make the record viewer active.

Control-Tab (in record viewer) or Shift-Tab (in records list)
Make the source list active.

Editing a rich text file or notes

Option-Tab
Begin a new bulleted list.
Tab

Increase the indentation of the current list item.
Shift-Tab

Decrease the indentation of the current list item.
Records list

Enter

Edit the filename of the selected record.
Option-Enter

Edit the title of the selected record.
Delete

Delete the selected records (if viewing a folder) or untag them (if viewing a tag).

Option-Delete
Delete the selected records to the trash.

Command—Up Arrow

View the container of the current folder or mailbox (i.e. go up a level in the hierarchy).

Command—Down Arrow

View the contents of the selected folder or mailbox (i.e. go down a level in the hierarchy).
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Down Arrow or Spacebar or Command-Control-Down Arrow

View the next record. Down Arrow works in the records list. Spacebar works in the
records list and in uneditable viewers. Command-Control-Down arrow works every-
where, even from an inspector window.

Up Arrow or Shift-Spacebar or Command-Control-Up Arrow
View the previous record.
Double-click or Return
Open With External Viewer.
Option-double-click or Option-Return
Open Source URL.
Drag to an EagleFiler browser window
Copy the record to another library.
Drag to a text window
Create a clickable link to the record.
Drag to Finder
Create an alias to the file.
Option-Drag to Finder
Create a copy of the file.

Source list

Left /Right Arrow
Collapse or expand the selected sources.
Option-Left /Right Arrow
Collapse or expand the selected sources and all their children.
Command—Up Arrow
Select the enclosing folder in the source list.
Double-click or Return
Open in New Window.
Enter
Edit the filename of the selected source.

Hiding
Option-click on another application

Switch to that application and hide EagleFiler. While hidden, EagleFiler will tem-
porarily show itself if you press the Capture with options key and then re-hide itself
automatically.

Option-click on an EagleFiler window

Bring EagleFiler to the front and hide the other applications.
Double-click on the horizontal split bar

Hide or show the record viewer.
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Many other keyboard shortcuts are available in the menus. You can customize the keyboard
shortcuts from the Keyboard pane in System Preferences.

4 Browser Windows

Each browser window contains a source list, a records list, a record viewer, and a toolbar. Drag
the split bars to resize the different portions of the window. Double-click a split bar to collapse it
entirely. Hold down the Option key while dragging a split bar to grow or shrink the window as you
drag.

You can use the Tab key to move between the different panes using the keyboard. When editing
in the record viewer, you may need to type Control-Tab rather than Tab (which will insert a tab
character into the document).

4.1 Source List

Drag files here to import them. You can drop onto a folder or tag source to import files directly
into that folder or to import them and assign that tag. You can use Exposé mid-drag to bring a
window to the front and reveal the source that you want to drop onto.
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The top-level sources are:

Library

Records

All the records in the library, from all the folders. Click the triangle next to the Records
source to see folder sources matching the folders in the library’s Files folder in the
Finder. You can drag and drop files and folders to re-arrange their hierarchy.

Trash
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The records that have been deleted from the library, but which are still available until
you empty the trash. This corresponds to the library’s Trash folder in the Finder.

Search For

Recently Added
The last 25 files that were added to the library.

Recently Modified
The last 25 files that were modified within EagleFiler or using another application.

Unfiled
Files that are at the top level of the library, e.g. ones that are directly in the Files
folder rather than in one of its sub-folders.

Untagged
Files anywhere in the library that do not have any tags (other than “note”).

Tags
Tag sources behave like playlists in iTunes or albums in iPhoto. Select a tag source to view
all the records with that tag. You can drag records onto a tag source to assign that tag to
them. Each record may appear in any number of tag sources. Deleting a record from a tag
source unassigns that tag; the record remains in the library. You can drag and drop tags to
re-arrange their hierarchy.

You can select more than one source at a time to view all their contents at once. You can type the
first few letters of a source’s name to select it. Press Return to open the selected source in a new
window, or Enter to edit its name.

4.2 Records List

The records list shows the contents of the selected source(s). If a folder or tag is the selected source,
you can drag files into the records list to import them with that folder or tag.
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The columns are:

Tags
The abbreviations for the assigned tags.

Count (#)

The number of pages in a PDF, messages in a mailbox, or attachments in a message.

Icon

An icon that shows the record’s type.

Title

The subject of a message or title of a document. For most document types, the title is separate
from the filename, e.g. it’s set in the Properties window in TextEdit and in Microsoft Word.
If the title is blank, this column shows the filename.

From

The sender of a message, author of a document, or domain of a Web page.

The recipient of a message or document.

Date Modified

The date the record’s contents was modified. For a file, this is the file’s modification date.
For a message, this is when the message was received.

Date Added
The date the record was added to the library.

Date Created

The date the record’s file was created.
Size

The amount of disk space used by the record.
File

The name of the file containing the record.
Kind

The type of the record.

Label
The Finder label of the record’s file.

Container

The name of the folder or mailbox that the record is inside.
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Tag Names

The full names of the assigned tags.

Drag and drop the column headers to change their order. Click the 57 or Control-click on a column
header to choose which columns are visible.

You can type the first few letters of a record’s title to select it. Double-clicking a record in the list
(or pressing Return) is equivalent to choosing Open With External Viewer. Option-double-clicking
is equivalent to choosing Open Source URL. Press Enter to rename the selected file or Option-Enter
to change its title.

4.3 Record Viewer

The record viewer shows the contents of the selected record. Text, RTF, and RTFD records can
be edited directly in the viewer. EagleFiler knows how to display many different kinds of files. If
it does not natively understand a file’s format, EagleFiler uses Quick Look to display a preview of
the file.

There is also a tags bar at the bottom of the viewer for assigning or unassigning the tags of the
current item.
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Sublect: Re: Binding to a Singleton T
From: Mike Abdullah <mike abdullah®@gmail com=
Date: September 27, 2006 6:1227 PM EDT

To: Shaun Wexler <devy@macfoh.coms
Ce: =cocoa-dev@lists.apple.coms

As an experiment, | just created a plain HSODocument based app and
added an HSUserDefaul tsController to the document nib.

Hhen | launch it with ObjectAllos, | can see that an instance of
MsUserDefaul tsContraller is created for ewvery document.

Hould it then be a reasonable assumption that based on this | should
subclass H50bjectControl ler to always attach itself to my Singleton

class? That way | will have my Singleton with multiple controllers
attached.
MHike.

On 26 Sep 2806, at 17:45, Shaun Hexler wrote!

¥ 0n Sep 26, 2086, at 9182 AM, Mike Abdullah wrote:

¥

*» Becaouse it's a singleton. | want to bind to it from my document
¥ MIB, and by instantiating the class in the HIBE will result in
*omultiple instances of my class. There will be one instance for
#roewery document — hot something | want!

Bk

¥y olnnmyg app | hawe a singleton class that behawves kinda Like
»»»» MSUserDefault=s. So |'m wondering, what's my best bet for how to
#¥%¥ go about binding to this class from a documant HIE.

x

* A nib file contains archived copies of gour objects, which are

* instantiated in the app using —initHithCoder i and that ultimately
Peoalls —init on gour object. “Your singleton class should override e
* +allocHithone! to prevent the creation of additional objects. *
* Your =ingleton instance can then intercept either of the init L
Tags: flagged y

While the record viewer has focus, you can press Command-Delete to delete the current record(s).

Control-click on a selected word or phrase to set that phrase as the tag, filename, from, or title.
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4.4 Searching

The search box lets you filter the records of the selected sources to display only those records that
match the search criteria.

Q.- attributes

¥ Anywhere

Filename Modified

Frﬂm rm.r J..luf"l' v P

Ci Nates 06 12:56 PM

| Tags |r::-5 11:34 PM
Title {06 5:30 AM m
S
| To/Ce /06 11:46 AM 4
ed f06 3:15PM v

= Mo Recent Searches |

¥ Match Partial Words

Search Syntax Reference
-

There are two kinds of indezxed searches:

Anywhere
Searches the contents of the records, as well as the Title, From, To, Cc, attachment names,

tags, and notes.

Notes

Searches the notes of the records.
These support an enhanced query syntax:

&, AND
Boolean AND. The <space> character also represents a Boolean AND.

|, OR

Boolean inclusive OR.
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I, NOT, -

9 9
Boolean NOT. For example, apple -orange finds records that contain apple and do not
contain orange.

G
Opening and closing delimiters for logical grouping. For example, (apple AND orange) OR
(apple AND pear) finds records that contain apple and another fruit, but not ones that
contain only apple.
Opening and closing delimiter for phrase-based searching. Phrase-based searches find records
that contain all of the words in sequence.

*

Wildcard for prefix or suffix. Ignored in phrase-based searches. To search for a partial word,
use two *’s, e.g. *ant* will find ant, repellant, anthem, and words with ant in the middle.
If Match Partial Words is checked, EagleFiler will find partial word matches without your
having to type the wildcards each time.

There are also five kinds of exact searches:

Filename

Searches the filenames as displayed in the records list.

From

Searches both the names and e-mail addresses.

Tags
Finds records that have the specified tag names. If Match Partial Words is not selected,
tag searching is exact, so you must type the complete tag names (with the proper case).
To/Cc

Searches both the names and e-mail addresses.

Title

Searches record titles and message subjects.

For both indexed and exact searches, you can restrict a search to records with certain tags by adding
tag:<tagname> at the beginning of the query. (This syntax is not available in smart folders; there
you should create a separate Tags criterion.) The search will then match only the records with all
of those tags. For example, searching for tag:apple steve means to search for steve and show
only the records with the apple tag. Searching for tag:mac tag:ipod halo !bungie means to
find all the records that include the word halo, do not include the word bungie, and have both
the mac and ipod tags.

To perform complex searches with multiple criteria, use the New Smart Folder. .. command.
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5 Menus

5.1 The EagleFiler Menu
5.1.1 About EagleFiler

The About EagleFiler window shows the credits, as well as download and support information.

You can always download the latest version of EagleFiler from the EagleFiler Web site??.
Questions about EagleFiler may be sent to eaglefiler@c-command.com®’. I'm always looking to
improve EagleFiler, so please feel free to send any feature requests to that address.

To make sure that you have the latest version of EagleFiler, you can use the Software Update
feature or subscribe to the EagleFiler News mailing list3'. The traffic on this list is very low, only
one message per new version of EagleFiler.

The EagleFiler RSS feed?? contains update notices and other EagleFiler news.

The EagleFiler forum?®? is the place to talk with other EagleFiler users, share tips and tricks, and
ask questions.

5.1.2 Software Update

Click the Check Now button, and EagleFiler will tell you whether a newer version is available for
download. By default, EagleFiler will automatically check for new versions each time it is launched
and once per day. You can disable this feature by unchecking the checkbox.

If a new version is available, EagleFiler will tell you what’s new in that version. Click Download to
have EagleFiler download the .dmg file for the new version to your Internet downloads folder. (You
can change the folder in Safari’s preferences.) Click Download & Install to have it download the
.dmg and then update the installed EagleFiler application to the new version.

To check for a new version, EagleFiler contacts a Web server at dreamhost.com. EagleFiler trans-
mits the following information to the server: the name of the product (EagleFiler) and its version,
the version of Mac OS X, whether EagleFiler has been purchased, the values of certain esoteric
preferences, and the name of the current language. This information is used to guide future devel-
opment. No personal information is transmitted.

nttp://c-command.com/eaglefiler/
30nailto:eaglefiler@c-command.com

3mttp://c-command. com/eaglefiler/support
32nttp://c-command.com/blog/category/eaglefiler/feed
33nttp://c-command. com/forums/forumdisplay.php?f=7
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5.1.3 Purchase

This window lets you buy EagleFiler. If you've already purchased EagleFiler but it’s running in
demo mode, you can you enter your name and serial number to personalize your copy of EagleFiler
and remove the demo limitations.

EagleFiler has a free trial period that lasts for 30 days or 7 launches, whichever is longer. To use
EagleFiler beyond the demo period, you must purchase it. This entitles you to free updates and
support.

To purchase, choose Purchase. .. from the EagleFiler menu. You can use the Purchase button
to enter the online store.

Soon after paying, you’ll receive an e-mail with your serial number. Enter the name and serial
number from the e-mail into the Purchase window and click Personalize. If you need to re-

install EagleFiler, you can simply re-enter your name and serial number and click Personalize;
there’s no need to purchase again.

If you purchased EagleFiler but cannot find your serial number, click the Lost Your Serial
Number? button. This will open a form where you can enter your e-mail address and look up
your order information.

A license for EagleFiler is good for one person or one computer. You can install it on one Mac,
and everyone sharing that Mac can use it (on that Mac). Alternatively, you can install it on your
desktop Mac and your laptop; you can then use it on either machine, provided that no one is using
it on the other machine.

5.2 The File Menu

5.2.1 New Library...

Creates a new library. Double-click the .eflibrary file to open the library in EagleFiler. You can
move the library folder around in the Finder, so long as it isn’t currently open in EagleFiler.

See also:

e How can I encrypt my files?

e How can I access my library from multiple Macs?

5.2.2 New Record > Rich Text File

Creates a new RTF or RTFD file inside the selected source.
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If the File column is visible and editing is enabled, EagleFiler brings the filename into edit mode
so that you can set the name of the newly created file. When you’re done, press Tab or click in the
viewer to begin entering the contents of the file. If the File column is hidden or editing is disabled,
EagleFiler opens a sheet that lets you enter the name of the new file.

5.2.3 New Record > Plain Text File

Creates a new plain text (UTF-8) file inside the selected source.

If the File column is visible and editing is enabled, EagleFiler brings the filename into edit mode
so that you can set the name of the newly created file. When you’re done, press Tab or click in the
viewer to begin entering the contents of the file. If the File column is hidden or editing is disabled,
EagleFiler opens a sheet that lets you enter the name of the new file.

5.2.4 New Record > Open Stationery Folder

You can create any type of new file from within EagleFiler. Whichever files you put in the
Stationery folder become available as templates in the File > New Record menu.

If the File column is visible and editing is enabled, EagleFiler brings the filename into edit mode
so that you can set the name of the newly created file. When you’re done, press Tab or click in the
viewer to begin entering the contents of the file. If the File column is hidden or editing is disabled,
EagleFiler opens a sheet that lets you enter the name of the new file.

5.2.5 New Folder...

Creates a new folder in the source list of the current library. You can set a custom icon for the
folder by selecting it in the Finder, choosing File > Get Info, clicking on the icon, and pasting
your own image.

If a smart folder is selected, creates a folder for holding smart folders rather than a folder for holding
files.

5.2.6 New Tag

Creates a new tag and selects it in the source list. If records are selected, they are assigned the
new tag. If a tag is selected, the new tag becomes a subtag of that tag. You can drag and drop
tags to re-arrange their hierarchy.
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5.2.7 New Browser Window

Creates an additional browser window for viewing the contents of the current library.

5.2.8 New Smart Folder. ..

A smart folder is like a saved search; it shows shows records in the library that match certain criteria.
EagleFiler has four built-in smart folders: Recently Added, Recently Modified, Unfiled, and
Untagged. This command lets you create your own smart folders.

You can organize smart folders into folders. To do this, select a smart folder and choose New
Folder. ... Then re-arrange the smart folders using drag and drop.

Creating and editing smart folders requires Mac OS X 10.5; however, once created, the smart folders
can be used with Mac OS X 10.4.

5.2.9 Edit Smart Folder...

The Conditions tab lets you set the criteria that determine which records are shown in the smart
folder.

Search inside: 'rE Records hﬂ # subfolders W mailboxes
[ Any i) af the following: +
[ Tags ) (contains anyof 3|  drakt | = x
Il 2| af the following: =) i
(Datecreated &) (isafter  :) /3172008 11:59:58 pM [2) (=)
| Date created 3 s before =) 10y L2008 12:00:00 AM T W=riE

® (Cancel) (0

Search inside
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This pop-up menu lets you select a folder, a mailbox, or the entire library to determine which
records the smart folder can display.

subfolders

If this is checked, EagleFiler searches the entire contents of the folder or library. If it’s
unchecked, it only searches the first level of files in the folder.

mailboxes

If this is checked, when EagleFiler encounters a mailbox it searches the messages inside of it.
If you don’t need to search the messages, unchecking this will make the search go faster.

Now that you’ve chosen which records EagleFiler will search, you can create an unlimited number
of criteria to narrow down the results. Click 4+ to add a criterion or - to remove one. Option-click
4+ to add a new Any/All/None grouping of criteria. You can drag and drop to re-arrange the
criteria.

The possible criteria are:

Anywhere

Searches the contents of the records, as well as the Title, From, To, Cc, attachment names,
tags, and notes. The detailed search options are described in the Searching section.

From

The names and e-mail addresses.
To/Cc

The names and e-mail addresses.

Title

Record titles and message subjects.

Count

The number of pages in a PDF, messages in a mailbox, or attachments in a message.

Source URL
The URL that a record was downloaded from.

Label
The Finder label of the record’s file.

Notes

The notes, set in the Info inspector.

Tags

The full names of the assigned tags.
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Filename

Searches the filenames as displayed in the records list.
Size

The amount of disk space used by the record.
Kind

The type of the record, as shown in the records list.

Container name

The name of the folder or mailbox that the record is inside.

Date added
The date the record was added to the library.

Date created

The date the record’s file was created.

Date modified
The date the record’s contents was modified. For a file, this is the file’s modification date.
For a message, this is when the message was received.

Every record

This is useful when combined with subfolders and mailboxes. When you click on a folder
in the source list, EagleFiler shows only the immediate contents of the folder. If you create a
smart folder using Every record, EagleFiler will show the contents of the folder and of its
subfolders.

The Actions tab lets you control what happens when you drag a record onto the smart folder.
Actions can add tags, remove tags, set the label, or move the records to a folder.
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| Conditions = Actions |

When records are dragged into the smart folder:

M Add tags: [ final | ]
W Remove tags: draft

1 Setlabel: | () Nene 4]

R Move to: | = Records 5

@ (Cancel) (@06

s

Creating and editing smart folders requires Mac OS X 10.5; however, once created, the smart folders
can be used with Mac OS X 10.4.

5.2.10 Open Library...

Opens a .eflibrary file, letting you view the library in EagleFiler.

When you open a library, EagleFiler will automatically verify that all of the files are present, backup
the metadata, and copy the tags to the Spotlight comments (if you've selected that option). To
skip these operations, hold down the Shift key when opening the library.

If you hold down the Command and Option keys when opening a library, EagleFiler will show
the Rebuild Indexes dialog. Rebuilding increases the speed of Anywhere and Notes searches,
compacts the index, and repairs any damage to it. For example, you might want to rebuild the
indexes if you’ve deleted a lot of files from the library, or if an Anywhere or Notes search is not
finding a record that you think should be in the index.

When rebuilding an index you can choose whether EagleFiler should index words or phrases. In-
dexing for word searches is much faster, but searching for multiple words will find all the documents
that contain those words anywhere in the document. Indexing for phrase searches lets you search
for a group of words that appear near each other in a document, however indexing will take longer
and the index files will be several times as large.
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5.2.11 Import URL(s)...

Opens a sheet for importing one or more URLSs into the current library, using the Web page format
chosen in the preferences. The text field will be pre-filled with the contents of the clipboard. If you
enter a URL that’s not for a Web page (e.g. the URL of a PDF or image file) EagleFiler imports
the file directly rather than converting it to a Web archive, PDF| etc.

5.2.12 Import File(s)...

Opens a sheet that lets you choose one or more files or folders to be imported into the current
library.

5.2.13 Export...
Opens a sheet that lets you choose a folder to which the selected records will be exported.

e The selected files/folders will be copied into the folder.

e Individual selected e-mail messages will be exported as a single mailbox file. To access
the messages, import them into a mail program or EagleFiler. For example, to import the
messages into Apple Mail, choose File > Import Mailboxes. . ., select the mbox files radio
button, click Continue, and then choose the folder containing the exported mailbox file.

Please note that, because the library is open, it is not necessary to export files in order to open
them with other applications. You could instead use the Open With External Viewer or Reveal In
Finder commands. The Export... command is intended for when you want to make copies of the
selected files or when the selected records are scattered throughout the library so that they would
not be easy to access from the Finder.

5.2.14 Backup Metadata

Metadata is EagleFiler-specific information such a record’s title, from, checksum, source URL, tags,
and notes. It is stored inside the .eflibrary file.

EagleFiler will automatically backup a library’s metadata when it’s opened and also periodically
thereafter. You can manually backup the metadata by holding down the Option key and choosing
Backup Metadata from the File menu.

Metadata is backed up to invisible EagleFiler Metadata.plist files inside the library folder.
These are standard Mac OS X property lists that can be viewed in TextEdit and processed by
many other programs.
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The backups allow EagleFiler to reconstruct all of your metadata if the .eflibrary file is damaged
or deleted. To restore a library:

1. Create a new library.

2. Import the contents of the old library’s Files folder. EagleFiler will copy the files into
the library (preserving their hierarchy) and automatically restore the metadata from
the backup.

3. Close the library.

4. In the Finder, replace the contents of the new library’s Smart Folders folder with the
contents of the old library’s Smart Folders folder.

5.2.15 Empty Trash...

Empties the trash of the current library. Hold down the Option key to skip the warning.

5.2.16 Print

EagleFiler will print either the list of records or the contents of the record viewer, depending on
which has focus.

5.3 The Edit Menu
5.3.1 Undo/Redo

Most actions in EagleFiler can be undone and redone, and EagleFiler supports multiple levels of
undo. When you close a library or empty the trash, EagleFiler clears the list of undoable actions
for that library.

5.3.2 Copy

Copies the selected text, the titles of the selected records or sources, or the names of the selected
tags.
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5.3.3 Copy Record Link

Copies a x-eaglefiler URL to the clipboard for each selected record. Opening the URL will
launch EagleFiler, open the library, and select the record so that its contents are shown in the
viewer.

Instead of copying and pasting, you can also drag a record into a text view to create a link to it.
Links will continue to work as you re-arrange the files within the library. However, if you move
the library folder or rename the .eflibrary file in the Finder, previously copied x-eaglefiler

URLs for that library will break. Links to individual e-mail messages will break if you merge the
message’s mailbox with another mailbox, as that will delete the original mailbox.

5.3.4 Copy Source URL

Copies the original http URLs for the selected Web Archive records. For other kinds of records,
copies file URLs for the files in the library.

5.4 The View Menu
5.4.1 Message > Raw Source

If this is checked, the viewer will show the raw RFC-8223% source for e-mail messages. If it’s
unchecked, the viewer will instead show the decoded Subject, From, Date, To, and body of the
message.

5.4.2 Message > Plain Text

If this is checked, EagleFiler will show all e-mail messages in plain text format. For HTML-only
messages, a plain text representation will be created. If this is unchecked, HTML messages will be
shown using rich text and plain text messages will be shown in plain text.

5.4.3 PDF > Next/Previous Page

These commands let you control which page of a PDF is displayed in the record viewer. There are
several ways to change the page without using the menu bar:

3nttp://www.ietf.org/rfc/rfc0822.txt
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e (lick on the PDF page, so that it gets keyboard focus, and then press the Down or Up arrow
key. In order for this to work, View > Zooming > Zoom to Fit must be checked.

e Press Command—Left Arrow or Command—Right Arrow.
e Control-click on the PDF page and use the commands in the contextual menu.

e Use the View > Customize Toolbar command to add Next and Previous toolbar buttons
for changing the page.

e Use the Keyboard pane of System Preferences to change the keyboard shortcuts for
Next Page and Previous Page.

5.4.4 Show > Source List

Hides or shows the source list. As a shortcut, you can double-click on the divider.

5.4.5 Show > Record Viewer

Hides or shows the record viewer. As a shortcut, you can double-click on the divider.

5.4.6 Show > Deleted Messages

E-mail messages that you've deleted are still stored in their mailbox files, but they are hidden from
view. This option lets you see all of the messages, even the deleted ones. To undelete a message,
select it and press Delete.

5.4.7 Show > Messages in Records Source

If this is checked, EagleFiler will show e-mail messages (from all your mailboxes) as well as files in
the Records source. Uncheck it if you want to avoid the clutter of seeing all the e-mail messages,
or if viewing the library is slow because you have lots of messages. This setting is saved per-library.

5.4.8 Show > Messages in Tag Sources

If this is checked, EagleFiler will show e-mail messages (from all your mailboxes) as well as files
in tag sources. Uncheck it if you want to avoid the clutter of seeing all the e-mail messages, or if
viewing tag sources is slow because you have lots of messages. This setting is saved per-library.
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5.4.9 Allow Editing in Record Viewer

This controls whether Text, RTF, and RTFD records can be edited directly in the record viewer,
without opening the file in another application. You might uncheck this if you want to avoid making
accidental changes while viewing a record.

5.4.10 Enclosing Record

View the container of the current folder or mailbox (i.e. go up a level in the hierarchy).

5.4.11 Contents of Record

View the contents of the selected folder or mailbox (i.e. go down a level in the hierarchy). For
example, if the Records source is selected, you can use the search box to enter the name of the
folder or mailbox that you want to view, select it in the record list, and then choose Contents of
Record. This is often quicker than expanding the various folders inside the Records source to
find the one you want.

5.4.12 Previous/Next Record

These commands select the previous or next record in the record list. This lets you change which
record is being viewed while the viewer pane has keyboard focus.

When the records list or the record viewer has keyboard focus, you can type Spacebar or Shift-
Spacebar to select the next or previous record.

5.4.13 Open in New Window

This opens a new browser window in EagleFiler to view the selected records.

5.5 The Record Menu
5.5.1 Mark as Unread/Read

Add (or remove) the “unread” tag to the selected records.
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5.5.2 Mark as Flagged/Unflagged

Add (or remove) the “flagged” tag to the selected records.

5.5.3 Tag

Gives keyboard focus to the tags text field at the bottom of the browser window, which lets you
edit the tags of the selected record.

Tags: rmac Mmusic

5.5.4 Set Label

Lets you set the Finder label of the selected records. Since e-mail messages do not appear as distinct
files in the Finder, setting the label of a message sets the Finder label of the message’s mailbox.

5.5.5 Batch Change...

This window lets you set the title, from name, label, tags, and notes of multiple selected records at
once. You can either Append or Replace. For example, appending tag mac will add that tag to
the selected records, while Replace would add the mac tag and remove any pre-existing tags.
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{*) Append () Replace

1 Title:

1 From:

™ Label: [ @ Red B2
M Tags: followup

1 Motes:

( Cancel :] f—ﬁl(—)
s

There are keyboard shortcuts for Append (Shift-Command-A), Replace (Shift-Command-R),
Label (Command-3), Cancel (Command-. or Escape), and OK (Enter).

5.5.6 Convert For Editing

Converts the selected Web archives to (editable) rich text files, preserving the tags, notes, source
URL, and other metadata.

5.5.7 Verify

When you open a library, EagleFiler checks that all the files and notes are present. The Verify
command does this, and it additionally checks that their contents are what EagleFiler was expecting.

This can help you detect file corruption before it becomes a serious problem. For example, if there
is damage to your disk and a file becomes corrupt, you’ll learn of the problem as soon as you use the
Verify command. Without Verify, you would only learn of the problem when you tried to access
the file (perhaps a long time in the future), and perhaps not even then, because the corruption
might not be readily apparent. Because you learn about the damage early, you can restore a correct
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version of the file from a backup, rather than filling your future backups with damaged copies of
the file.

In order to detect when files have changed, EagleFiler stores a checksum of each file. If EagleFiler
reads a file and calculates the same checksum that it got before, it knows that the file has not
changed. Thus, if the file was in good condition before, it is still in good condition. If EagleFiler
calculates a different checksum, that means that the file’s contents are different.

Sometimes, the checksum should be different. For example, when you edit a file, you intentionally
change its contents, resulting in a different checksum. When you edit a file within EagleFiler,
EagleFiler automatically updates its stored checksum to match the file’s new contents. Thus, if
you only edit files using EagleFiler, the checksums will always be in sync with the files’ contents,
and any checksum that doesn’t match means that the file is damaged.

EagleFiler also allows you edit files using other applications. For example, you can double-click a
Microsoft Word document to open it in Word, make some changes, and choose File > Save. In
this case, the file has changed, but there is no way for EagleFiler to know that this is because of
what you did in Word. The changes could have been due to damage. Thus, if you edit a file outside
of EagleFiler, you must use the Update Checksum to tell EagleFiler that the file’s current contents
are correct. EagleFiler will then update its stored checksum to match.

Verify is a specialized feature for people who want extra data integrity protection. If you don’t
need this, or if you frequently edit files outside of EagleFiler and don’t want to have to Update
Checksum, then you can simply ignore the Verify command. EagleFiler will then behave like a
normal Mac application: it won’t complain about files being different than it expected, but neither
will it detect when they are damaged.

5.5.8 TUpdate Checksum

The Update Checksum command tells EagleFiler that you have edited the selected file(s) using
another application. This is necessary for proper operation of the Verify command and duplicates
detection.

If you do not edit files outside of EagleFiler, or if you do not use Verify or duplicates detection,
you can ignore the Update Checksum command.

5.5.9 Merge Mailboxes

Merges the selected mailboxes into a single mailbox file with the name and location of the oldest
mailbox in the selection. The tags and notes of the messages are preserved. The original mailboxes
are then moved to the trash.

Merging mailboxes can reduce clutter in the source list and speed up EagleFiler.
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5.5.10 Reply to Message

Lets you reply to a message in your default e-mail program.

5.5.11 Open With External Viewer

Opens the selected records in a specialized viewer application such as Preview, Safari, or Mail.
Folders and mailboxes will open in a new window in EagleFiler. If you open an e-mail, the message
that’s displayed in Mail is the message that’s stored in EagleFiler’s library, not the original message
that was imported from Mail (which might already have been deleted).

If a search is in effect, EagleFiler passes the search string to the external viewer so that it can show
you the matches in the document.

Double-clicking a record and pressing Return are shortcuts for choosing this command from the
menu. Hold down the Option key to open the source URL instead of the stored file.

To change which application will open a document, use the Reveal in Finder command, then choose
Get Info from the Finder’s File menu and look in the Open with section of the info window.

5.5.12 Open Source URL

With a Web archive record (or an RTFD file converted from a Web archive) selected, this opens
the (live, not archived) Web page in your Web browser.

You can also Option-double-click on a record to open its source URL.
5.5.13 Open in Delicious

This opens a Web archive’s URL in the Delicious® social bookmarking site to help you find related
pages.

5.5.14 Quick Look

EagleFiler uses Apple’s Quick Look?® technology to preview in the record viewer files that it doesn’t
natively understand. The Quick Look menu command lets you open a larger preview window.

3nttp://delicious.com
36nttp://www.apple.com/macosx/features/quicklook.html
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5.5.15 Reveal in Finder

This shows the selected records in the Finder. If you have Path Finder®” running, the files will be
revealed in it instead.

5.6 The Format Menu

This menu contains commands for use when editing a rich text file in EagleFiler’s viewer or when
editing a note. You can change the font and style and add clickable links, lists, and tables. In
addition to the standard Mac OS X formatting commands, EagleFiler provides a command called
Highlight, which makes the background of the selected text yellow, as if it had been drawn over
with a highlighter.

5.7 The Window Menu
5.7.1 Show Info

This window lets you view and edit the properties of the selected records. You can type Tab to
move between to text fields, or Control-Tab to move out of the notes text view.

3™http://www.cocoatech. com
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% 139443430. V11932039 _.pdf

FOF
PDF (20 KB)

Title: | 100 Rebate For MacBook (2.4 GHz Core
2 Duo, 2 GB RAM, 250 GB) Black

From: mshirley

URL: http://www.amazo...7975585163C1748

Date: m Added Modified

2/26 /2008 11:59:14 AM @
Label: [ ) None |-$-]
Tags: note rebate waiting

Notes:

- Amazon product page (live link)
- Crder confirmation (Web archive in EF]|

File Properties

This shows the file’s name, kind, size, and dates, as well as EagleFiler metadata such as the
title, source URL, and from.

If a record doesn’t have a title and you haven’t set one manually, EagleFiler will use the
filename (without the extension) as the title, and the title will stay in sync with the filename
if you rename it.

Label

This is the Finder label of the file. In EagleFiler, the label is shown as the background color
in the records list and also in the Label column. E-mail messages are stored as mailboxes,
not as individual files, so all the messages in the mailbox share the mailbox file’s label. You
can edit the label names from the Finder’s Preferences window.
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Tags

This shows the tags assigned to the record. You may find it more convenient to create and
assign tags by typing them in the text field than by using the Show Tags command.

Notes

Notes support rich text, clickable links, embedded graphics, tables, etc. Most of the commands
for editing notes are in the Format menu. As a shortcut, you can type Option-Tab to start
a bulleted list or Option-Shift-Tab to dedent the current list item. EagleFiler automatically
adds the “note” tag to records that have notes, and removes it from ones that don’t.

5.7.2 Show Tags

This window shows a list of tags for the current library.

favorite
fireball

flagged

intermet
note
quote
travel
unread
Warning

The columns are:

vV
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The box is checked if all of the selected records in the browser window have this tag. It shows
a - sign if some (but not all) of the selected records have the tag. It is disabled if no records
are selected.

The abbreviation (if any) for the tag. Abbreviations are shown in the Tags column of
the records list; for example, the “unread” tag is shown as a blue e. Double-click on an
abbreviation to edit it. The abbreviation can be composed of ordinary letters, or of special
symbols. To enter a special symbol, first double-click to edit the abbreviation. Then click
the Characters button to open the Character Palette. Make sure that you are using a
View that does not have a Font pop-up menu; this way you can ensure that you enter a
true Unicode character. Click on the character that you want, then click the Insert button.

Name

The name of the tag. Double-click on a name to edit it. (The names of built-in tags such as
“unread” cannot be edited.) Each tag must have a unique name.

You can give the tags palette keyboard focus by:

Clicking in its title bar.

Choosing Show Tags from the Record menu.

Clicking the Tags button in the toolbar of a browser window.

Editing an abbreviation or name.

Once the tags palette has keyboard focus, you can:

e Type the first few letters of a tag’s name to select it in the list.

e Press the spacebar to toggle whether the selected records in the browser window have the
selected tags. This is like checking or unchecking the boxes of all the selected tags at once.

e Click the Colors button in the toolbar. Then choose a new color for the selected tag(s) and
abbreviation(s).

You can Control-click on a tag to reveal it in the source list, thus showing all the records with that
tag.

5.7.3 Show Tag Cloud

The Tag Cloud window shows a compact listing of all the tags. You can click on a tag to toggle
whether it’s assigned to the selected record.
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administration advice apple

book buy draft favorite film
final flagged followup internet

iphone local mac music
politics quote research trawvel
unread

5.7.4 Activity

EagleFiler can do many operations—such as adding files and URLs to the library, indexing,
verifying—in the background. This window shows a list of the tasks that EagleFiler is currently
working on for each library.

Sample Library: Indexing records
e

196 of 531 — About 3 minutes

Sample Library: Verifying data integrity
e

About & seconds

5.7.5 Drop Pad

The Drop Pad tells you which library is active. You can drag files onto the Drop Pad to import them
into the active library. You can use the pop-up menu on the Drop Pad to change the active library
(without introducing window clutter). The Drop Pad also provides information about whether
EagleFiler can capture from the current application.
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© O DropPad

Crag and drop here to
add to the library.

5.7.6 Errors

This window shows a list of errors that have occurred since you launched EagleFiler. You can select
errors and copy them to the clipboard.

5.8 The Help Menu

This menu provides access to the full EagleFiler documentation (in Apple Help or PDF format) as
well as a link to the technical support Web site.

5.9 The Dock Menu

The Open Recent commands let you access EagleFiler libraries that might not currently be open.
The Capture From <Application> command is equivalent to pressing the capture key. The
Import Clipboard command will import any text on the clipboard as a new rich text file. The
New Record commands let you create new files in the current library.
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6 Preferences

Capture key: F1
Capture with options: | CF1
Web page format: f Web Archive Hll

Spotlight comments: f Import as notes and tags Hl'

Sources font: _ Lucida Grande 11 Select. ..

™ Use small source icons

Lists font: _ Lucida Grande 11 Select. ..

Rich text font: _ Helvetica 12 Select. ..

Plain text font: Mornaco 9 Select. ..

Search highlight color:

| Quoted Text Colors

v e

Level 1 Lewvel 2 Level 3 Lewvel 4 Lewvel 5

W Remember open libraries between launches
M Copy tags to Spotlight comments
" Allow duplicate files in library

<
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6.1 Capture key

You can always import into EagleFiler using Import URL(s). .., Import File(s)..., or drag and
drop. However, if you are already viewing the information that you want import, it’s much easier
to just press the capture key.

Capture key: F1

When you press the capture key, EagleFiler automatically determines what you're currently viewing
(or what you have selected) and imports it into the current library. There are many applications
that support capture. EagleFiler will play a camera sound and show a camera icon in its Dock tile
to let you know that the capture has started. When it’s finished, if you have Growl®® installed,
you’ll see a notification bubble.

By default, the capture key is F1. If you have a notebook or an aluminum Apple keyboard, you’ll
need to hold the frn key to type F1 unless you’ve checked Use all F1, F2, etc. keys as standard
function keys in the Keyboard & Mouse preferences pane. (This setting is called Use all F1,
F2, etc. keys as standard function keys in Mac OS X 10.4.) You can also change the capture
key to a different key or key combination if you prefer.

If you’d rather import just the selected text instead of the entire Web page or document, you can
use drag and drop or the EagleFiler: Import service (Command%) instead of the capture key.

EagleFiler must be running in order for the capture key to work. Thus, you may wish to add
EagleFiler to your Login Items in the Accounts pane of System Preferences. You can easily do
this by clicking on the EagleFiler icon in the Dock and choosing Open at Login.

6.2 Capture with options

Capture with options: CF1

3¥nttp://growl.info
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This works like the capture key: you press it while in one of the applications that support capture,
and EagleFiler imports the “current item” into your library. The difference is that you can specify
which library to import into, and which folder within that library. You can also set the title, from
name, label, tags, and notes:

Source: http://www.apple.com/iphone/specs.html

Destination: | /%) Sample Library 13| | (L] iPhone )

Title: | Automatic

From: | Automatic

Label: [ @B Red B

Tags: unread apple iphone
imac

iphone i
Notes: Use noles to record your =

thoughis about the documeant you're capturing or about what
you need 10 do with it. Noles can include lists, tables, and
images, as well as different forts and shies.

(_Cancel ) ((Capture’)

i

EagleFiler remembers this metadata (except the title) for each library, so it’s easy to quickly capture
a bunch of related items. Pressing the Reset button clears the metadata and sets the folder so
that EagleFiler once again imports into the Unfiled source.

There are keyboard shortcuts for choosing the library (Command-1), folder (Command-2), Label

(Command-3), Reset (Command-K), Cancel (Command-. or Escape), and Capture (Enter).
Once the folder menu is open, you can select a folder by typing the first few letters of its name.

6.3 Web page format
When you import a Web page, EagleFiler can save it using the following formats:

Bookmark
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A .webloc file that stores the URL and page title. This does not save the contents of the
page, thus conserving disk space but restricting your search options.

PDF

PDF files preserve the text, formatting, clickable links, and images. Web pages containing
HTML frames cannot be saved as PDF files; when importing such pages, EagleFiler will save
them as Web archives.

Plain Text
Plain text files include the text content of the page, with no formatting or images. Thus,
they make very efficient use of disk space.

Rich Text
RTF files preserve the text, formatting, and clickable links, but not the images.

Rich Text With Images
An RTFD package that preserves the text, formatting, clickable links, and images.

Web archive

Web archives preserve the entire page contents in its original format (HTML, CSS, images).
They’re slower to display than PDFs, but you can resize the window to change the displayed
width, and you can adjust the font size (often more useful than zooming a PDF). Web archives
can be viewed on Macs (using Safari) and iPhones (using Air Sharing3?), but currently there
are no Windows or Linux applications to display them.

6.4 Spotlight comments

This setting controls what happens to a file’s Spotlight comments when you import it into Eagle-
Filer.

Ignore

EagleFiler preserves the Spotlight comments.

Import as notes and tags

EagleFiler extracts tags (prefixed by & or marked using Punakea’s format) and assigns them
as FagleFiler tags. It imports the remaining comments text as notes.

Import as tags

FEach word in the comments is imported as a tag.

39nttp://www.avatron.com/products/
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6.5 Fonts

Sources

Used in the source list in browser windows.

Lists

Used in the records list in browser windows and in the list of tags in the tags inspector.

Rich text

Used for e-mail header information, HTML messages, and as the default font for notes.

Plain text

Used for plain text e-mail messages and text files.

The fonts for Web archives are mostly controlled by the Web archives themselves. The default font
families and sizes can be controlled using Safari’s preferences.

6.6 Search highlight color

This is the color that EagleFiler uses to emphasize the search terms in the records list and record
viewer.

6.7 Quoted Text Colors

EagleFiler colors plain text e-mail messages according to the number of quote characters at the
start of each line. The pop-down menu lets you choose a preset coloring scheme.

6.8 Remember open libraries between launches

If this is checked, EagleFiler will remember which libraries were open when you quit it, and it will
re-open them the next time EagleFiler is launched.

In addition, you can put aliases to your favorite libraries in the folder:

/Users/<username>/Library/Application Support/EagleFiler/Startup Items

so that EagleFiler will always open them at launch. You can hold down the Shift key at launch to
prevent it from re-opening the libraries or opening the startup items.
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6.9 Copy tags to Spotlight comments

If this is checked, EagleFiler will set the Spotlight comments for each file to the names of the tags
that it’s been assigned. This enables you to search for a file using Spotlight by typing tag names
as part of the query. Any existing comments will be lost. If this is not checked, EagleFiler will
preserve the existing Spotlight comments when importing files.

EagleFiler will automatically copy the tags to the comments when a library is opened and pe-
riodically thereafter. You can force it to update the comments by using the Backup Metadata
command.

There is an esoteric preference to control the tag prefix that’s added to each tag name in the
comments.

6.10 Allow duplicate files in library

Normally EagleFiler will prevent you from importing a file if a file with the same contents (in the
data fork) is already in the library. You can check this option if you prefer to import every file,
even duplicates. In order for duplicate detection to work, your files’ checksums must be up-to-date.
For more information, please read about the Verify and Update Checksum commands.

6.11 Esoteric Preferences

You can set esoteric EagleFiler preferences by clicking the links on this page. Unlike with regular
preferences, you must generally quit and re-launch EagleFiler in order for an esoteric preference to
take effect.

AutomaticallyBackupMetadata

EagleFiler automatically backs up your libraries’ metadata (and, at the same time, copies
tags to the Spotlight comments, if you've asked it to do that), but you can turn this feature
off for a slight speed increase.

CalculateFolderSizes
This controls whether EagleFiler calculates folder sizes to display them in the records list.
Turning off this feature will increase EagleFiler’s responsiveness.
ClearSearchWhenChangingSources

Normally EagleFiler preserves your search query when you view different sources, so that you
can easily search different folders without retyping it. You can optionally set EagleFiler to
clear the search so that clicking on a different folder takes EagleFiler out of search mode and
shows you all the records.
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x-eaglefiler://default?k=AutomaticallyBackupMetadata&v=YES
x-eaglefiler://default?k=AutomaticallyBackupMetadata&v=NO
x-eaglefiler://default?k=CalculateFolderSizes&v=YES
x-eaglefiler://default?k=CalculateFolderSizes&v=NO
x-eaglefiler://default?k=ClearSearchWhenChangingSources&v=NO
x-eaglefiler://default?k=ClearSearchWhenChangingSources&v=YES

DefaultMessageEncoding

When a message doesn’t specify which text encoding it uses, EagleFiler has to guess. An

incorrect guess may cause the message to display using strange accents or garbage characters.

By default EagleFiler guesses MacRoman, but you can change it to guess ISO Latin 1 instead.
EnableWebPluglns

Normally, EagleFiler will show content from Web plug-ins (such as Flash) when displaying
an HTML file or Web archive. However, you can also disable plug-ins if you don’t want to
see this content.

FolderMailboxTitleSeparateFromFilename
Normally EagleFiler will keep the titles of folders and mailboxes in sync with their filenames.
You can also set it to allow the titles to be distinct from the filenames. This is potentially
useful if you need to manage a folder structure using fixed filenames but you want to have
longer, more descriptive titles in EagleFiler.

HighlightSearchMatches
Normally EagleFiler will highlight in the record viewer the words that match your search
query. Disabling this feature will provide a speed increase.

ImportSpotlight Keywords
EagleFiler normally ignores Spotlight keywords when importing files to avoid cluttering your
tags list with irrelevant or incorrect entries. You can also set EagleFiler to import Spotlight
keywords as tags if you generally like the keywords that are assigned to your files.

InvisibleMetadataFiles

This controls whether EagleFiler Metadata.plist files are visible or invisible.

MarkNewRecordsAsUnread
Normally EagleFiler will mark newly imported records as unread, but you can also tell it to
leave them untagged.

MaxEditableTextFileSizeInMB

Normally EagleFiler will display the entire contents of a text file, even if it’s many megabytes.
This can take a long time, especially when using Mac OS X 10.4. You can speed it up by
setting EagleFiler to only show the first 10 MB of a text file.

MediaStyle
If a Web page includes multiple stylesheets, you can choose whether EagleFiler displays it
using the print stylesheet or the default stylesheet.

TagCommentPrefix

If a record is tagged unread and flagged EagleFiler will normally set the Spotlight comments
to flagged unread. You can set the prefix to & so that it instead sets the comments to
&flagged &unread (for better integration with software like TagBot and Quicksilver) or go
back to the default of using no prefix.
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x-eaglefiler://default?k=DefaultMessageEncoding&v=macroman
x-eaglefiler://default?k=DefaultMessageEncoding&v=latin-1
x-eaglefiler://default?k=EnableWebPlugIns&v=YES
x-eaglefiler://default?k=EnableWebPlugIns&v=NO
x-eaglefiler://default?k=FolderMailboxTitleSeparateFromFilename&v=NO
x-eaglefiler://default?k=FolderMailboxTitleSeparateFromFilename&v=YES
x-eaglefiler://default?k=HighlightSearchMatches&v=YES
x-eaglefiler://default?k=HighlightSearchMatches&v=NO
x-eaglefiler://default?k=ImportSpotlightKeywords&v=NO
x-eaglefiler://default?k=ImportSpotlightKeywords&v=YES
x-eaglefiler://default?k=ImportSpotlightKeywords&v=YES
x-eaglefiler://default?k=InvisibleMetadataFiles&v=NO
x-eaglefiler://default?k=InvisibleMetadataFiles&v=YES
x-eaglefiler://default?k=MarkNewRecordsAsUnread&v=YES
x-eaglefiler://default?k=MarkNewRecordsAsUnread&v=NO
x-eaglefiler://default?k=MaxEditableTextFileSizeInMB&v=0
x-eaglefiler://default?k=MaxEditableTextFileSizeInMB&v=10
x-eaglefiler://default?k=MediaStyle&v=print
x-eaglefiler://default?k=MediaStyle&v=
x-eaglefiler://default?k=TagCommentPrefix&v=%26
x-eaglefiler://default?k=TagCommentPrefix&v=

7 Frequently Asked Questions

7.1 Why doesn’t my serial number work?

You need to enter the serial number name and serial number exactly as they appear on your order
confirmation e-mail. If you no longer have this e-mail, you can look up the name and number.
Launch EagleFiler and choose Purchase from the EagleFiler menu. Then click the Lost Your
Serial Number? button.

7.2 How can I speed up EagleFiler?

Getting a faster Mac, a faster hard disk, or more RAM would of course make everything faster,
but there are also some less expensive ways to speed up EagleFiler:

1. EagleFiler is designed to perform best when it is kept running, with a library open. It
will be faster to leave it running (perhaps hidden) in the background than to open and
close it each time you add a file to the library. You can easily hide EagleFiler by holding
down the Option key as you click to switch to another application. Additionally, leaving
EagleFiler running will allow you to use its capture key.

2. If you just want to add a file to a library, without waiting to open the library or
EagleFiler, you can save the file in the library’s To Import folder so that it will be
imported the next time EagleFiler opens that library.

3. EagleFiler is designed to support multi-gigabyte libraries with many thousands of files.
However, as with all software, viewing a library (or folder) with fewer files in it will
generally be faster than viewing one with many. (The sizes of the files don’t have much
effect on EagleFiler’s performance.) EagleFiler lets you create multiple libraries, so one
way to increase performance is to use several smaller libraries instead of one huge one.
This can also provide an additional level of organization.

4. Fewer large mailboxes are faster than many small ones. You can combine multiple
mailboxes using the Merge Mailboxes command.

5. Emptying EagleFiler’s trash will reduce the number of records in the library, and thus
speed it up.

6. Importing files is faster when nothing is selected in the source list and the Activity
window is closed.

7. In order to enable quick searching, EagleFiler maintains indexes of all the files and
e-mail messages in a library. By default, EagleFiler indexes for phrase searches. This
allows the most flexible searching, but indexing can take a lot of time and disk space.
If you don’t need to do phrase searches, you can rebuild the indexes for word searching.
This will reduce the size of the indexes and speed up indexing going forward.
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10.

11.

12.

13.

7.3

In order to improve performance and make more efficient use of disk space, EagleFiler prefers to
store e-mail messages in mailbox files (using the standard “mbox” format), and it does not allow
them to be moved from one mailbox to another. Thus, it is best to organize messages into the
mailboxes that you want (and to delete messages that you don’t want to save) before importing
them into EagleFiler. Nevertheless, several organization options are available once your messages

. Viewing search results in large documents will be faster if you turn off search match

highlighting.

. When EagleFiler opens a library, it checks to make sure all of the files are present, backs

up the metadata, and copies the tags to the Spotlight comments. You can hold down
the Shift key when opening the library to skip these steps, or click the x buttons in the
Activity window to cancel them.

Displaying and scrolling the records list will be faster if you tell EagleFiler not to
calculate folder sizes.

Viewing large text files will be faster if you use Mac OS X 10.5 instead of 10.4 or if you
set EagleFiler to only show the first few MB of large files.

Opening a library will be faster if the selected source (when you closed the library) does
not contain many files. For example, if you had Records selected, and it was sorted by
modification date, EagleFiler would have to load all the files (and possibly all the e-mail
messages) and look up their modification dates. If a subfolder (or no source at all) were
selected, the library would open more quickly because EagleFiler would initially only
have to load the contents of that folder.

When creating a smart folder, put the most restrictive criteria higher in the list.

How can I move messages between mailboxes?

are in an EagleFiler library:

1.

You can merge multiple mailboxes into one. For example, if each month you import
mailbox A into EagleFiler, you’ll end up with lots of A mailboxes in the library, each
containing one month’s worth of messages. By merging all of the A mailboxes into one,
you can reduce visual clutter and make EagleFiler run more efficiently.

. You can drag messages from mailboxes to folders. This deletes the messages from the

mailbox and stores the messages as individual .eml files in the folder. This is not as
efficient as storing one file per mailbox, but it allows for more flexible organization.

. You can organize messages (from different mailboxes) into tag sources. As with playlists

in iTunes, each message can be in more than one tag source at a time.

. The easiest way to avoid storing duplicate messages is to delete messages in your mail

program after you've imported them into EagleFiler. You can also delete individual
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messages from an EagleFiler mailbox, although this will not save disk space; it will only
hide the messages from view.

7.4 How can I access my library from multiple Macs?

EagleFiler library folders can be stored wherever you want. You can take a library with you by
keeping it on a USB keychain drive, iPhone, iPod, or external hard drive.

If you choose to keep the library on your Mac, Mac OS X’s built-in file sharing and Web sharing
can be used to make its contents available on other Macs.

Another option is to store the library on your iDisk. To do this, first go to the iDisk tab of the
MobileMe/.Mac pane of System Preferences. Click Start to turn on iDisk syncing and make
sure that it’s set to Manually.

iDisk Sync: On

r‘—‘\.l Click Stop to return to using your Internet-based iDisk. You will be able to access

Mﬂ/ your iDisk only when you're connected to the Internet.

Update: [:)Jlﬂl.umr’natin:all',-r @ln'!anuall*.ur

Create a new EagleFiler library and save it on the iDisk. For greater speed, behind the scenes
your Mac will store a copy of the library on your hard disk for EagleFiler to work with, and it will
synchronize this with your iDisk. When you're finished using the library for a while, close it in
EagleFiler. If the library is encrypted, eject it. Then click the sync button next to your iDisk in
the Finder’s source list:

¥ DEVICES

L]
| Encrypted Stuff &

To access the library on another Mac, click the sync button and then open the library in EagleFiler.
When you're finished, close the library and click the sync button again. In this way, multiple Macs
can share the same EagleFiler library. Just remember to always sync before opening the library
and after closing it, and only access the library from one Mac at a time.

Additionally, MobileMe/.Mac lets you view the contents of your iDisk from a Web browser. This
is another way to make the files in your EagleFiler library accessible from other Macs, and even
from iPhones and Windows PCs. (Encrypted libraries can only be accessed from a Mac.)

70



7.5 How can I put my library on my iPhone?

EagleFiler stores your files in standard formats, and the iPhone can read most of them. There are
a variety of applications in the App Store that let you transfer files between a Mac and an iPhone
and view them on the iPhone:

Air Sharing® (Recommended. It has a great interface, supports Web archives, and EagleFiler
can directly open libraries that are stored on the phone.)

DataCase®!

Files*?

FileMagnet*3

MobileFinder#4

These also work with the iPod touch, of course.

7.6 How can I encrypt my files?

EagleFiler supports encryption at the library level. You can have multiple libraries, each of which
is either encrypted or not encrypted. An encrypted library works just like a normal library except
that all aspects of it (the files, notes, metadata, search indexes, and temporary files) are unreadable
until the proper passphrase has been entered.

When creating a New Library. .., the Encrypt library using passphrase option lets you store
the library on an encrypted disk image. The entire library (including all the files, notes, and
indexes) will be stored in a disk image file that is encrypted using AES-128 or AES-256*°. To
access the library, double-click the disk image file and enter the library’s passphrase. The library
will appear as a white icon on your desktop, and you can double-click the .eflibrary file to open
it in EagleFiler. (You can also access all the files in the library directly from the Finder.) When
you're done with the library, close it in EagleFiler and eject the library from your desktop to lock
it again. Now it can only be accessed by people who know the passphrase.

On Mac OS X 10.4, EagleFiler always creates a sparse disk image file using AES-128 encryption.
On Mac OS X 10.5, you can choose the format and encryption level of the disk image:

“Onttp://www.avatron.com/products/

http: //www.veiosoft.com

“nttp://www.olivetoast.com/Files/
“http://www.magnetismstudios.com/filemagnet/
Y“http://www.pixiotech.com/Site/MobileFinder . html
“nttp://en.wikipedia.org/wiki/Advanced_Encryption_Standard#Security_of_AES
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Sparse Disk Image
Creates a .sparseimage file that’s compatible with Mac OS X 10.4 and later.

Sparse Bundle Disk Image

Creates a .sparsebundle package that requires Mac OS X 10.5 or later, but which is much
more efficient for backups.

128-bit AES Encryption

Compatible with Mac OS X 10.4 or later. The U.S. National Security Agency (NSA) has
announced that it may be used for SECRET level documents.

256-bit AES Encryption

Requires Mac OS X 10.5 or later. It is slower but even more secure than AES-128. The NSA
has announced that it may be used for TOP SECRET level documents.

You can quickly access an encrypted library by creating an alias of its .eflibrary file. When
you double-click the alias, the Finder will ask for the passphrase and then open the library with
EagleFiler.

An encrypted library will only consume the amount of disk space needed to hold its files, indexes,
and temporary files. However, you must set a maximum library size that controls how large the
library can grow. The larger the maximum size, the more overhead there is for encryption. For
example, a library with a 1 GB maximum size will have about 26 MB of overhead, while a library
with 500 GB maximum size will have about 111 MB of overhead. If your library reaches the
maximum size, you can create a new, larger library and copy all of the files to it by dragging the
Records source from the old library to the new one.

To change the passphrase of an encrypted library, eject the library, then open Disk Utility. Choose
Images > Change Password. .. and then select the disk image file.

7.7 How can I copy my tags to another library?

Once you’ve created some tags and set them up the way you want, it’s easy to use them in another
library. Assign the tags to a file, and then drag it into the other library. EagleFiler will transfer the
tags (along with their abbreviations, colors, and hierarchy) to the other library. This is really just
a special case of a general EagleFiler feature that metadata (tags, notes, titles, etc.) are preserved
when copying files between libraries.

8 Legal Stuff

Distribution
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Please distribute the unmodified EagleFiler-1.4.dmg file on the Web, LANs, compilation CD-
ROMs, etc. You may not charge for it (beyond a reasonable cost for media) or distribute the
contents of the disk image file in isolation. You may not distribute your serial number.

Limited Warranty

The software is provided “as is,” without warranty of any kind, express or implied, including but not
limited to the warranties of merchantability, fitness for a particular purpose and noninfringement.
In no event shall the authors or copyright holders be liable for any claim, damages or other liability,
whether in an action of contract, tort or otherwise, arising from, out of or in connection with the
software or the use or other dealings in the software.

License

A license for EagleFiler is good for one person or one computer. You may install it on one Mac,
and everyone sharing that Mac may use it (on that Mac). Alternatively, you may install it and
use it on multiple Macs (e.g. your desktop Mac and your laptop); then you (and no one else) may
use it on any of those Macs. For multiple users on multiple Macs, you should purchase multiple
licenses.

Copyright and Trademarks

EagleFiler and this manual are copyright © 2002-2008 by C-Command Software?6. All rights
reserved.

EagleFiler is a trademark of C-Command Software. Mac is a registered trademark of Apple Com-
puter. All other products mentioned are trademarks of their respective owners.

Components

The following open-source components are used in EagleFiler:

e Regular expression support is provided by the PCRE?" library package, which is open source
software, written by Philip Hazel, and copyright by the University of Cambridge, England.

8 49

e Core Foundation®® is available under the terms of the Apple Public Source License®.

e Growl® is Copyright © The Growl Project, 2004-2007 All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permit-
ted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

46mailto:mjt@c-command.com

“Thttp://www.pcre.org
“®nttp://www.opensource.apple.com/darwinsource/10.4.10.x86/CF-368.28/
“Onttp://www.opensource.apple.com/apsl/

5Onttp://growl.info
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2. Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

3. Neither the name of Growl nor the names of its contributors may be used to en-
dorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBU-
TORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FIT-
NESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, IN-
DIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CON-
TRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHER-
WISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

e Thanks to Allan Odgaard for some code snippets that are used in the Software Update
installer.

e libffi’!: Copyright © 1996-2003 Red Hat, Inc.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the “Software”), to deal in the Software without restric-
tion, including without limitation the rights to use, copy, modify, merge, publish, distribute,
sublicense, and/or sell copies of the Software, and to permit persons to whom the Software
is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONIN-
FRINGEMENT. IN NO EVENT SHALL CYGNUS SOLUTIONS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CON-
TRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

e PTHotKey®2: Copyright (c) 2003-2004 Rogue Amoeba Software LLC, Quentin D. Carnicelli,
Finlay Dobbie, Vincent Pottier

5lhttp://sourceware.org/libffi/
52http: //www.rogueamoeba. com/utm/posts/Random/Homegrown_Developer_Tools-2004-07-14-12-00
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Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the “Software”), to deal in the Software without restric-
tion, including without limitation the rights to use, copy, modify, merge, publish, distribute,
sublicense, and/or sell copies of the Software, and to permit persons to whom the Software
is furnished to do so.

THE SOFTWARE IS PROVIDED “AS IS,” WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONIN-
FRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

e PyObjC?: Copyright 2002, 2003 - Bill Bumgarner, Ronald Oussoren, Steve Majewski, Lele
Gaifax, et.al.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the “Software”), to deal in the Software without restric-
tion, including without limitation the rights to use, copy, modify, merge, publish, distribute,
sublicense, and/or sell copies of the Software, and to permit persons to whom the Software
is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONIN-
FRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

e Python®%:

1. This LICENSE AGREEMENT is between the Python Software Foundation (“PSE”),
and the Individual or Organization (“Licensee”) accessing and otherwise using this
software (“Python”) in source or binary form and its associated documentation.

2. Subject to the terms and conditions of this License Agreement, PSF hereby grants
Licensee a nonexclusive, royalty-free, world-wide license to reproduce, analyze, test,
perform and/or display publicly, prepare derivative works, distribute, and otherwise
use Python alone or in any derivative version, provided, however, that PSF’s License
Agreement and PSF’s notice of copyright, i.e., “Copyright (© 2001, 2002, 2003,

5%nhttp://pyobjc.sourceforge.net/
5nttp://www.python.org/

75


http://pyobjc.sourceforge.net/
http://www.python.org/

2004, 2005, 2006 Python Software Foundation; All Rights Reserved” are retained
in Python alone or in any derivative version prepared by Licensee.

3. In the event Licensee prepares a derivative work that is based on or incorporates
Python or any part thereof, and wants to make the derivative work available to
others as provided herein, then Licensee hereby agrees to include in any such work
a brief summary of the changes made to Python.

4. PSF is making Python available to Licensee on an “AS IS” basis. PSF MAKES
NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED. BY
WAY OF EXAMPLE, BUT NOT LIMITATION, PSF MAKES NO AND DIS-
CLAIMS ANY REPRESENTATION OR WARRANTY OF MERCHANTARBIL-
ITY OR FITNESS FOR ANY PARTICULAR PURPOSE OR THAT THE USE
OF PYTHON WILL NOT INFRINGE ANY THIRD PARTY RIGHTS.

5. PSF SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF
PYTHON FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAM-
AGES OR LOSS AS A RESULT OF MODIFYING, DISTRIBUTING, OR OTH-
ERWISE USING PYTHON, OR ANY DERIVATIVE THEREOF, EVEN IF AD-
VISED OF THE POSSIBILITY THEREOF.

6. This License Agreement will automatically terminate upon a material breach of its
terms and conditions.

7. Nothing in this License Agreement shall be deemed to create any relationship of
agency, partnership, or joint venture between PSF and Licensee. This License
Agreement does not grant permission to use PSF trademarks or trade name in a
trademark sense to endorse or promote products or services of Licensee, or any
third party.

8. By copying, installing or otherwise using Python, Licensee agrees to be bound by
the terms and conditions of this License Agreement.

e Shortcut Recorder®:

Copyright (c) 2006, contributors to ShortcutRecorder. (See the contributors®.)

All rights reserved. Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

— Redistributions of source code must retain the above copyright notice, this list of condi-
tions and the following disclaimer.

— Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

— The name of the contributors may not be used to endorse or promote products derived
from this software without specific prior written permission.

55http ://wafflesoftware.net/shortcut/
5nttp://wafflesoftware.net/shortcut/contributors/
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THIS SOFTWARE IS PROVIDED BY THE CONTRIBUTORS “AS IS” AND ANY EX-
PRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IM-
PLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE CONTRIBUTORS BE LI-
ABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCURE-
MENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LI-
ABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

e vobject®™: Copyright (c) 2004-2006 Jeffrey Harris. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permit-
ted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include
the following acknowledgment: “This product includes software developed by the
Apache Software Foundation (http://www.apache.org/?®).” Alternately, this ac-
knowledgment may appear in the software itself, if and wherever such third-party
acknowledgments normally appear.

4. The names “Apache” and “Apache Software Foundation” must not be used to
endorse or promote products derived from this software without prior written per-
mission. For written permission, please contact apache@apache.org®.

5. Products derived from this software may not be called “Apache”, nor may “Apache”
appear in their name, without prior written permission of the Apache Software
Foundation.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED WAR-
RANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIB-
UTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEM-
PLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THE-
ORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (IN-

*Thttp://vobject.skyhouseconsulting.com/
5nttp://www.apache.org/
mailto: apache@apache.org
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CLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the
Apache Software Foundation. For more information on the Apache Software Foundation,
please see http://www.apache.org/®.

Portions of this software are based upon public domain software originally written at the
National Center for Supercomputing Applications, University of Illinois, Urbana-Champaign.

9 Version History

1.4—October 14, 2008

Highlights

You can now create custom smart folders, which can contain an unlimited number of
criteria, optionally using nested Any/All/None criteria. Creating and editing smart
folders requires Mac OS X 10.5; however, once created, the smart folders can be
used with Mac OS X 10.4.

Smart folders can now be organized into folders.

You can define actions to occur when you drag a record onto a smart folder. For ex-
ample, you could make a smart folder that shows records with a certain combination
of tags, and that will assign those tags to dragged records.

You can now create any type of new file from within EagleFiler. To do this, choose
New Record > Open Stationery Folder from the File menu. Whichever files you put
in the Stationery folder become available as templates in the File > New Record
mentu.

You can now drag messages out of mailboxes to convert them to freestanding .eml
files. It’s less efficient to store messages individually rather than in mailbox files,
but there are also several advantages: the messages can be stored alongside other
types of files, they can be freely moved between folders, and they are searchable by
Spotlight.

Added a Tag Cloud window, which shows a compact listing of all the tags. You can
click on a tag to toggle whether it’s assigned to the selected record.

Added a Find panel for searching within PDFs and Web archives.

Added a preference to control which format Web pages are imported in. The sup-
ported formats are: Bookmark, PDF, Plain Text, Rich Text, Rich Text With Images,
and Web Archive (the default).

Added a preference to control what happens to Spotlight comments when importing.
This is useful, e.g. if you had already used another application to tag your files or
if you had entered notes from the Finder. If you tell EagleFiler to Import as
tags, each word is imported as a tag. If you tell it to Import as notes and
tags, FagleFiler extracts tags (prefixed by & or marked using Punakea’s format)
and imports the remaining comments text as notes.

Onttp://www.

apache.org/
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Added commands to the contextual menus (Assign Tag, Set Filename, Set
From, Set Title) so that you can quickly turn the selected text into metadata.

File Formats

Added New Record > Plain Text File command.

EagleFiler can now display Microsoft Word 2007 (.docx) files (requires Mac OS X
10.5).

EagleFiler can now display and edit OpenDocument Text (.odt) files (requires Mac
0S X 10.5).

EagleFiler can now display and search XML and binary property list (.plist) files.
Now imports .webloc files as-is rather than converting them to Web archives.
EagleFiler now imports . eml files as-is rather than converting them to single-message
mailboxes.

Bean®' documents are now imported as a separate file type rather than as RTFD.

Interface

Added Quick Look command, which opens a Quick Look preview of the selected
records in a separate window (requires Mac OS X 10.5).

Added an Enclosing Record command in the View menu. Replaced the Select
Source command with the similar but more useful Contents of Record command in
the View menu. As a result, you can now use Command—Up Arrow and Command—
Down Arrow to navigate up and down the hierarchy of folders and mailboxes.
Added Search for Selection contextual menu command.

When you mouse over a link in a Web view, EagleFiler now shows the URL at the
bottom of the window.

Revised the toolbar icons and simplified the default toolbar configuration.

If there are no matches for a search, EagleFiler draws the records list background
in yellow.

Adjusted the unread and flagged menu item titles and toolbar labels for consistency
with Mail.

Increased the resolution of the Dock badges.

The viewer now shows some helpful text describing the “note” tag.

Moved Show Inspector and Show Tags from the Record menu to the Window
menu and renamed Show Inspector to Show Info.

Capture

Can now capture from Entourage®, and preserves the message flags, categories, and
projects. If you want EagleFiler to skip a message, you can assign it the category
“OmitFromArchive”.

Can now capture from PowerMail®?

, and preserves the message status and label.
Can now capture from Preview®*, if you make it scriptable5?.

Sihttp: //www.
Snttp: / /.
S3http://www.
Snttp: //www.
Snttp://www.

bean-osx.com
microsoft.com/mac/products/entourage2008/default.mspx
ctmdev. com/powermailb.html
apple.com/macosx/features/pdf/
macworld.com/article/53391/2006/10/previewscript.html
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Can now capture from Together®, and preserves the tags, comments, labels, and
ratings.

When capturing from Mailsmith%”, EagleFiler can now import individual messages
(before, only mailboxes were supported), and it now preserves the message status,
label, and notes.

When capturing from Camino%®, EagleFiler now reads the URL of the current tab
rather than the first tab.

In the Capture With Options window, if you edit the tags and then choose a different
library, EagleFiler no longer overwrites the tags with the default ones for the new
library.

Importing

You can now import Web pages using bookmarklets5.

Empty files and files that contain only a resource fork (such as font suitcases) no
longer count as duplicates.

Added an esoteric preference for importing Spotlight keywords as tags.

When you try to import a file that’s already inside of the library folder, EagleFiler
can now reveal the file in the browser window.

If a connection times out while EagleFiler is importing a Web page, it will now retry
twice.

When importing bookmarks from a Web browser, EagleFiler now uses the titles
you’ve assigned rather than fetching them from the Web.

Miscellaneous

Encrypted libraries can now be created as sparse bundle images, for more efficient
Time Machine backups (requires Mac OS X 10.5).

Encrypted libraries can now use 256-bit rather than 128-bit encryption (requires
Mac OS X 10.5).

You can now type tag names directly into an Anywhere search.

You can now view messages in Microsoft Entourage instead of Apple Mail (requires
Mac OS X 10.5). To do this, Get Info on a .eml file in the Finder, choose Entourage
from the Open with pop-up menu, and click Change All.

The Copy Record Link command now creates links using persistent IDs so that they
will still work if you delete EagleFiler’s database and import the files into a new
library.

Added How can I put my library on my iPhone? section to the manual.

Added Shortcuts section to the manual.

Added an esoteric preference to clear the search field when you select a different
source.

You can now double-click a smart folder to open it in a new window.

%nttp://reinventedsoftware.com/together/
5"http://www.barebones . com/products/mailsmith/
58nttp://www.caminobrowser.org
%nttp://c-command.com/eaglefiler/bookmarklets
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EagleFiler now indexes a file’s Spotlight keywords for searching.
Improved auto-generated titles.
Improved the display of improperly encoded message headers.

Worked around a bug in Mac OS X 10.4 when highlighting matching search terms
in the records list.

Removes stray index files when opening the library.

If there’s an error getting the downloads folder for a software update, EagleFiler
now defaults to Downloads rather than Desktop.

No longer shows the __deleted__ tag in the records list.

The Untagged source now shows records that only have the “note” tag.
Improved parsing of invalid mbox files.

Improved error reporting when downloading Web pages.

Rewrote filesystem code to improve performance and error reporting.
Made various changes to improve interface responsiveness.

Note files now include a relative URL to the file that they’re attached to, so that
you can easily find the file if EagleFiler isn’t installed.

Added placeholder text to the Purchase window.
No longer lets Web pages steal focus from the records list.
You can now bring up the Find panel when the source list or records list has focus.

EagleFiler now saves damaged index files for possible future analysis of why Search
Kit couldn’t open them. It also tries multiple times to open indexes, since Search
Kit sometimes changes its mind about which indexes are valid.

Bug Fixes

If an unexpected error occurs while EagleFiler is emptying the trash, it no longer
leaves the library in an inconsistent state. Also, EagleFiler will now detect and
repair this sort of damage when opening a library.

Fixed a bug where a duplicate “From ” line could be inserted when generating an
mbox file from an Apple Mail mailbox. This was harmless but unsightly.

Fixed a bug where, in rare cases, two messages imported from Apple Mail could be
joined into one, so that it looked like some had been skipped.

Fixed a bug where EagleFiler changed the selection if you tried to delete a source
and then cancelled.

Fixed a bug where Reveal in Finder didn’t work when KeePassX was running.

Fixed a bug where you could, via the contextual menu, open a different page when
viewing a Web archive.

Fixed a bug where EagleFiler could freeze when revealing a non-existent file in the
Finder.

Fixed a bug where EagleFiler’s Web fonts would not be consistent with Safari’s if
you’d never changed the fonts in Safari’s preferences.

Fixed a bug where, when capturing multiple items with notes, some records without
notes would be assigned the notes from one of the other records.
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e Fixed a bug where certain errors when creating a new library were not correctly
reported.

e Fixed a bug where the PDF viewer state wasn’t always preserved.
e Fixed a bug where the title of text records wasn’t linked to the filename by default.

e Fixed a bug where newly added tags weren’t selected if you had been renaming
another tag.

e Fixed a bug where EagleFiler could crash when closing a browser window.

1.3.8—July 23, 2008

Fixed a regression where capturing from Firefox didn’t work.

1.3.7—July 22, 2008

Fixed a regression where editing a keyboard shortcut could cause EagleFiler to crash.

1.3.6—July 22, 2008

Opening the Capture With Options window is faster and uses much less memory.

When capturing a headline from NetNewsWire™, EagleFiler now preserves the flagged
status.

Improved the error message when capturing from Firefox”! 3 fails due to a bug in Firefox.
Fixed some small memory leaks.
Fixed bug where .eml files converted to mbox format weren’t From-escaped.

Moved .nib files that don’t need localization out of the English.lproj folder. This
should make it easier to run EagleFiler in a language other than English without changing
the default language on your Mac.

Fixed bug truncating filenames containing decomposed characters.

Improved the French localization.

1.3.5—July 2, 2008

Made various performance optimizations to the browser and activity windows.

If you click on a mailbox in the source list whose table of contents has not yet been
built, EagleFiler now reports this in the viewer so that it’s more clear why no messages
are shown yet.

Dropping between folders in the source list no longer targets the containing folder, since
this made the subfolder drop targets too small.

Improved the way EagleFiler handles special “merged” mailboxes when capturing from
Apple Mail.

Added EnableWebPlugIns to the esoteric preferences, so that you can prevent Web
plug-ins (e.g. Flash) from loading in EagleFiler’s viewer.

http://ranchero.com/netnewswire/
""http://www.mozilla.com/en-US/firefox/
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Capturing a mailbox in Apple Mail no longer captures its submailboxes, unless they’re
also selected.

Fixed bug extracting the metadata from files during import.

Fixed a bug where, in rare cases, EagleFiler would end up with two internal database
records for the same file. This could happen with Web archives in the To Import folder.

Fixed the title of the Copy Image command when Control-clicking on an image in the
viewer.

Fixed bug where EagleFiler would clear the display of the selected Web archive when
using Capture With Options.

Fixed regression where AppleScripting a browser window didn’t work.
Reduced the delay before showing the Capture With Options window.
The font-chooser text fields now draw the text centered.

Single-click editing in table and outline views now requires Mac OS X 10.5, since it now
relies on the standard OS functionality.

In certain circumstances, auto-updating no longer requires authentication.

Fixed bug where some operations in the Activity window would hang if the OS hung
while setting a Spotlight comment.

Worked around suspected OS bug, which sometimes caused a file’s creation date to
change when you changed the modification date.

Fixed bug where the Capture With Options window would be shown even if there were
no items to capture.

Fixed bug editing filenames with no extension in the records list.

1.3.4—June 3, 2008

Fixed regression where parts of the Drop Pad didn’t accept dropped files.
Fixed regression where source list titles sometimes would be truncated prematurely.
Fixed regression where the top of the viewer was cut off in the German localization.

Fixed regression where changes to the tags weren’t saved if you closed the window before
pressing Return/Tab or clicking elsewhere.

The default search scope is now Anywhere.

The divider in the Info inspector now remembers its position.

The Tags field in the Info inspector can now be made shorter.

Improved launching speed.

Added Importing Mail section to the manual.

Added FolderMailboxTitleSeparateFromFilename to the esoteric preferences.
Improved error reporting when capturing from Microsoft Word.

Fixed bug importing Apple Mail messages when running under certain non-English
locales.
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Worked around a framework bug that could cause errors when closing a library.
Removed logging of invalid URLs.

Updated the German localization.

1.3.3—May 20, 2008

Improved the speed of displaying large numbers of files or messages for the first time.
Can now capture from Opera’?.
Added New Rich Text File command to the Dock menu.
The Drop Pad is now resizable.

Worked around Mac OS X bug that prevented EagleFiler from indexing certain docu-
ments for searching.

The Capture With Options window no longer suggests the title from the previous cap-
ture, since that wasn’t very useful.

If a mailbox’s messages are not yet ready for display (because EagleFiler is rebuilding
the table of contents), the mailbox name is now shown in gray in the source list.

Added placeholder text to the tags bar so that it’s more clear that it’s editable.
Expanded the documentation for the Verify command.

On Mac OS X 10.4, the viewer pane now shows custom rather than generic icons for
files that it doesn’t know how to display. (On Mac OS X 10.5, it continues to use Quick
Look.)

When searching, EagleFiler now ignores trailing meta characters in the query string,
rather than returning no results.

The Drop Pad menu command now hides the Drop Pad if it was already visible.

Reorganized the Dock menu so that the fixed commands are easier to find with the
mouse.

Improved error reporting when capturing from a “merged” mailbox in Mail.
Adjusted spacing in source list.

Added “raised” background style to the label in the tags bar.

Skips importing .git folders.

Improved error logging.

Fixed bug where the Tags palette sometimes showed the tags for the wrong library.

Fixed bug where the Tags field in the Batch Change. .. window didn’t become checked
when you started typing tags in it.

Fixed bug with text color of non-highlighted text in selected rows of the records list,
when it didn’t have keyboard focus.

Fixed error resizing the browser window.

Fixed importing of Word documents with blank titles.

http://wuw.opera.com
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Fixed bug where the command in the Window menu said Activity Viewer instead of
Activity.

1.3.2—April 24, 2008

Faster indexed searches when lots of results are found.
Faster at displaying large text files when running on Mac OS X 10.5.

The Title and From fields in the Capture With Options window will now try to clean
up any text that you paste in, e.g. removing linebreaks and coalescing multiple spaces
into one.

Enlarged the Title field in the Capture With Options window.

Some errors now have a tooltip that shows which library they pertain to.
Preserves more file metadata when editing documents within EagleFiler.
EagleFiler can now import URLs that contain the | character.

Adjusted mail-related icons when running on Mac OS X 10.5.

Added MaxEditableTextFileSizeInMB esoteric preference, which lets you set EagleFiler
to only show the first few megabytes of large text files, so that they display more quickly.

Disabled undo in the Title and From fields in the Capture With Options window to
work around a bug in Cocoa.

Fixed bug where the viewer could lose keyboard focus when using Previous/Next Record.
Fixed bug where mailbox names were not indexed for Anywhere searches.
Fixed bug editing text or RTF documents that were stored on non-HFS volumes.

Fixed bug where indeterminate progress bars didn’t animate when running on Mac OS
X 10.5.

Fixed bug importing messages from Apple Mail that claimed to be sent in the year 2038
or later.

Fixed mbox separator-line dates for imported IMAP messages.

Fixed regression where files and messages didn’t sort together properly by modification
date.

Updated the .sdef file to the latest format.
Updated to Python 2.5.2.
Renamed the Activity Viewer window to Activity for consistency with Mail and Safari.

Fixed color of non-highlighted text in selected rows of the records list.

1.3.1—April 9, 2008

When searching the Tags scope (or using tag:<name> with another search scope), Ea-
gleFiler now lets you type incomplete tag names if Match Partial Words is checked.

The @ character is now allowed in tag names.

When using Capture With Options, any tags or notes that you set are now used in
addition to rather than instead of any tags or notes suggested by the capture script.
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Changes to notes are now undoable.

Improved responsiveness by limiting the number of simultaneous file copy operations.
Fixed regression where Copy tags to Spotlight comments didn’t work.

Fixed regression editing files in the viewer whose path contained non-ASCII characters.
Fixed regression deleting notes.

When you delete the selected sources, EagleFiler now selects the next source in the list
and maintains the scroll position.

Canceling a Capture With Options now brings you back to the application that you were
in.

The tag abbreviation column now sorts by the actual tag names, rather than by the
abbreviation symbols.

Worked around a Web Kit bug saving certain pages as Web archives.

Worked around OS bug that could cause a crash when resizing a browser window.
Tried to work around OS bug revealing files in the Finder.

After revealing a file in Path Finder”, brings Path Finder to the front.

Re-positioned Format menu for consistency with Mail.

Fixed a rare crash when searching a PDF.

Fixed bug where dragging records in the list sometimes required an extra click.

Fixed sorting of sources, records, and tags whose names contain combining marks.
Fixed bug where the contextual menu sometimes had duplicate Highlight commands.

Fixed bug where sometimes the original title of a document (stored in the file) wasn’t
indexed if you'd set a custom title in EagleFiler.

Fixed bug where .plist files were sometimes imported as text.

Fixed bug where a displayed Web archive could auto-open a window in the user’s Web
browser.

Fixed bug remembering the PDF zoom level.

Updated German localization.

1.3—March 11, 2008

Highlights

e Added Capture with options command (Option-F1 by default), which lets you set
the library, destination folder, tags, and other metadata right when you press the
capture key.

e Added Batch Change. .. menu command and button in the tags bar. This lets you
set the title, from name, label, tags, and notes of the selected records all at once.

e Now uses Quick Look to display file types that EagleFiler doesn’t natively under-
stand (e.g. Pages, Keynote, OmniGraffle, fonts). This feature requires Mac OS X
10.5.

http://www.cocoatech. com
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Added Untagged smart folder to the source list.
Added Date Created and Tag Names columns to the records list.
Added Set Label submenu and contextual menu.

Added specialized viewing and indexing support for iCalendar (.ics) and vCard
(.vcf) files.

Now indexes Skim™ notes attached to PDF and PDFD files so that you can search
for them within EagleFiler.

Revised the icons and layout throughout the user interface.
Made various optimizations so that EagleFiler is faster and more responsive.

Browser Windows

When creating new rich text files or notes, EagleFiler now creates RTF files instead of
RTFED ones when possible. RTF files are more compatible and faster. Additionally,
when editing files in the viewer, EagleFiler automatically converts between RTF and
RTFD depending on whether RTFD is required.

When using the Record > Tag command to jump to the tags bar, EagleFiler now
moves the insertion point to the end of the tags, rather than selecting all of them.

When you create a New Rich Text File within EagleFiler, it’s no longer marked
as unread.

The Open With External Viewer toolbar button now shows which application will
be used to open the file.

Added Update Checksum toolbar button.
Now shows tag colors in the source list.

You can now tab from editing the File column in the records list into the record
viewer, which makes creating new RTF files smoother. (Requires Mac OS X 10.5.)

When you open a library on a smaller screen than it was previously opened on,
EagleFiler now overrides the OS and shrinks the window so that it fits on the
screen.

Added Select Source to the contextual menu.

Added a custom drag image for the records lists.

Added ellipsis-truncation to column headers in the records list.
Increased the maximum width of the date columns.

Holding down Option to skip the confirmation when emptying the trash now works
from the contextual menu.

When displaying Usenet messages from mbox files, EagleFiler now shows the name
of the newsgroup in the To area of the viewer.

You can now copy an image file that EagleFiler’s displaying to the clipboard.

Now remembers between launches if you’ve set the PDF view to display continuous
or facing pages.

You can now press Command-Delete to delete the selected record(s) when the viewer
has focus.

"http://skim-app.sourceforge.net
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You can now double-click the drag strip to collapse the source list.
Increased the font size in the tags bar.

Capture

If no library is open when you press the capture key, instead of showing an error
alert, EagleFiler now opens the Capture with options dialog, which lets you open
or create a library to complete the capture.

Can now capture from Address Book™, Flock™ 1.0, iCab”" 4, Keynote™, Mind-
Manager™, Pages®®, OmniGraffled!, and TextMate82.

Revised the user interface for setting the capture key.

While EagleFiler is in the process of capturing (i.e. running the capture script or
showing the capture options dialog), it now badges the Dock icon with a picture of
a camera.

Added |creationDate| and |modificationDatel| options for capture scripts.
Improved preservation of modification and creation dates when capturing from DE-
VONthink Pro®?, MarsEdit®*, Journler®, and Yojimbo®.

Improved the reliability when capturing from WebnoteHappy®”, e.g. if it returns
invalid tag, note, or title information.

EagleFiler now creates the user Capture Scripts folder for you.

Miscellaneous

If EagleFiler is busy when you ask it to close a library, it now stops any existing
operations (except when doing so would cause data loss), so you no longer have to
wait and/or stop them yourself.

When dealing with “Bad Checksum” errors in the Errors window, you can now
update the checksums for multiple errors at a time, and after updating a checksum
EagleFiler removes the error from the window.

e Reduced EagleFiler’s RAM use for large libraries.

Importing

e Text dragged from a Web page is now imported as a Web archive instead of an RTFD

file. (If you want an RTFD file, you can use the Convert For Editing command.)

e In addition to checking periodically, EagleFiler nows checks the To Import folders

when it becomes the active application. This should get new files imported sooner.
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Now shows a single Growl notification for each batch of files imported, rather than
for each individual one.

Now shows a progress spinner next to the action menu while EagleFiler is busy
importing.

Changed the Dock icon indicator that shows when EagleFiler is importing. Instead
of a red circle, it now shows a downward pointing arrow.

Improved EagleFiler’s recovery when WebKit runs into an internal error while saving
a Web archive file.

Info Inspector

Added URL field.
Enlarged the Title field and Notes text view.

Now displays three dates—Created, Added, and Modified—and the creation and
modification dates are editable.

Fields that are unavailable are now disabled rather than just marked as uneditable.

Search
e Now shows the search scope beneath the search box so that it’s clear which parts of
the records you’re searching.
e When searching, you can now use OR as a synonym for |, and you can use -word as
a synonym for !word.
e EagleFiler is better at estimating how long indexing will take when some of the
records in the library are already indexed.
AppleScript
e The import command now returns a list of the imported records. This makes it
easier to set the properties of the new records. Additionally, import now waits
until the records have been imported before returning, so the script knows when the
import has finished.
e The import command now supports a deleting afterwards option, which makes
EagleFiler delete the source file after successfully importing it.
e You can now use the import command outside of a tell library document block;
it will then target the frontmost library.
e The source URL property is now settable.
Bug Fixes

The order in the labels pop-up menu now matches the Finder.

Now remembers the sorted column of the Tags inspector between launches.

Fixed bug where the source URL wasn’t set if you imported a URL of a file that
wasn’t a Web page.

No longer shows the Rebuild dialog when opening a library if you hold down other
modifier keys in addition to Command-Option.

If EagleFiler was unable to capture due to a bug in the Finder, the error message now
suggests using drag and drop, updating to Mac OS X 10.5, or disabling FileVault.

Now preserves the creation date when editing files within EagleFiler and when saving
notes.
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Fixed bug where the Import File(s)... command didn’t let you import items that
were next to the library folder.

Fixed bug where certain Apple Mail mailboxes (typically those imported from an-
other mail program) weren’t imported as mailboxes.

Fixed bug where the Reveal button in the Errors window didn’t work properly
for duplicate files that came from the To Import folder.

Fixed bug where the Highlight command didn’t work properly when no text was
selected.

Fixed bug where the Highlight toolbar button in the main browser window would
be enabled when editing a note.

Fixed bug where EagleFiler would add a uniquing number if you renamed a file/folder
to a name that differed only by case (and you were using a case-insensitive filesys-
tem).

Worked around a Cocoa bug that could, in rare cases, lead to an infinite loop when
saving the library.

Fixed bug where some Format > Font menu commands were enabled even though
they couldn’t be used because Allow Editing in Record Viewer was unchecked.

Fixed bug where toggling Allow Editing In Record Viewer didn’t take effect imme-
diately.
Fixed crash involving the tags bar.

Fixed bug where capturing just messages from an Apple Mail mailbox with sub-
mailboxes would import empty folders for the submailboxes.

Fixed bug where newly imported records sometimes didn’t sort properly by modifi-
cation date.

Fixed bug where the Info inspector sometimes didn’t show the correct record.
Fixed bug where custom icons on the To Import folder were not preserved.
The software updater is better at handling invalid downloads folders.

Fixed crash involving the Info inspector.

Fixed bug where Edit > Find > Library Search... didn’t bring the window to
the front.

Fixed bug hiding and showing the source list when running on Mac OS X 10.5.2.
Fixed bug checksumming packages containing symlinks.
Fixed bug where JavaScript was disabled in the viewer.

1.2.7—November 14, 2007

e If you create a New Rich Text File while one or more tag sources are selected, Eagle-
Filer now assigns those tags to it.

e Colored quote levels now work in HTML messages.

e You can now hold down the Option key to empty the trash without a warning.

e Now uses the proper Skim®® icon for PDFD files.

88nttp://skim-app.sourceforge.net
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Combined the three system services into one, which detects whether it was invoke with
a file, text, or URL(s). The keyboard shortcut can now be configured using System
Preferences rather than a separate utility.

If you make EagleFiler a login item, set it to be hidden, and have it set to open a library
when it’s launched, EagleFiler will now re-hide itself after opening that library.

Drag-importing from MacJournal works now.

The system service now works properly when EagleFiler wasn’t already running.
Control-clicking on a source group no longer selects it.

Improved scaling of the library document icon.

Fixed bug where the Apple Help didn’t work on Mac OS X 10.5.

Fixed regression where assigning/unassigning tags using the Spacebar in the Tags in-
spector didn’t always work.

Fixed bug displaying some encoded message subjects.
Fixed regression where the top couple pixels of the viewer could be cut off.

Fixed bug where the icons of some types of sounds, movies, or images showed the wrong
file type.

Fixed bug where the source list sometimes had the wrong background color.
Fixed ellipsis truncation of selected source names.
Updated German localization.

Added Korean localization.

1.2.6—October 24, 2007

Modernized the source list and buttons.

Capturing the selected mailboxes/messages from Apple Mail now works when an IMAP
path prefix is set.

Can now capture from MarsEdit® (based on work by Eric Blair).
Added support for Skim?® .pdfd bundles.

Tags in the tag bar and inspectors now have contextual menus that let you reveal them
in the source list, to see all the records with that tag.

Added French and German localizations.
There are new AppleScripts for importing from LaunchBar®' and Quicksilver®?.

You can now modify capture scripts while EagleFiler is open without having to relaunch
for it to notice the changes.

Improved import speed, particularly when the source volume is slow.

You can now cancel an import in the middle of EagleFiler checksumming a file.

89nttp://www.red-sweater.com/marsedit/
nttp://skim-app.sourceforge.net
9http://c-command.com/scripts/eaglefiler/launchbar-import-text
“http://c-command.com/scripts/eaglefiler/quicksilver-import-text

91


http://www.red-sweater.com/marsedit/
http://skim-app.sourceforge.net
http://c-command.com/scripts/eaglefiler/launchbar-import-text
http://c-command.com/scripts/eaglefiler/quicksilver-import-text

e Fixed bug where capturing from Apple Mail didn’t work on pre-release versions of Mac
OS X 10.5 Leopard.

e Capturing now works with pre-release builds of Camino 1.6.

e Select Source now preserves the selection in the records list after selecting the container
sources.

e Using the spacebar to toggle tags in the Tags inspector now interacts better with type-
selection.

e The search field now expands and contracts based on the available space in the toolbar.
e Convert For Editing now preserves the title and allows duplicates.

e After deleting a record or tag, EagleFiler will now select the next item in the list.

e Clicking a link to open another EagleFiler record now gives it keyboard focus.

e Now clears Web views that aren’t in use, saving memory and silencing sounds.

e Capturing PDF files from Safari now works when the Schubert|it PDF Browser Plugin
is installed.

e Renamed the Library source to Records.
e Improved capture script error reporting.

e Metadata files are now invisible by default, and you can prevent them from being created
automatically. There are esoteric preferences to control this. Also, EagleFiler avoids
writing metadata files to disk if they haven’t changed.

e After opening a library with EagleFiler 1.2.6, it will no longer be openable in previous
versions of EagleFiler. Of course, the files and metadata are still accessible in the Finder.

e Fixed color of selected tags in inspector.

e Fixed memory leak with the Activity Viewer window.

e Fixed progress bar inaccuracy when importing a folder of files.

e Fixed bug importing .eml files exported from Thunderbird.

e Fixed bug where certain types of sound files were imported as text.

e Fixed bug displaying attachment names that used the Bigh character set.

e Choosing colors is more robust and defaults to the spectrum view.
1.2.5—August 21, 2007

e Can now capture from Cyndicate?3.
e Fix bug where Flash was disabled in Web views.

e Fixed bug where the insertion point would sometimes move if you edited in the record
viewer and then manipulated the window before it had saved.

e Improved the robustness of the startup code to prevent some rare problems when launch-
ing EagleFiler.

e Improved handling of FDF files.

%nttp://cynicalpeak.com/cyndicate/
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Fixed rare errors importing lots of files at once.

Verifying checksums is faster.

1.2.4—August 2, 2007

The records list uses gentler background colors to indicate the files’ labels.

Now shows labels in the source list.

Added keyboard shortcuts for going to the next or previous PDF page.

Now shows tooltips in the source list.

The records list now has an alternating background color, like the Leopard Finder.

Improved the responsiveness of the user interface when highlighting search matches in
PDFs.

Fixed incorrect outline/table row heights when using certain fonts.
Now preserves extended attributes when copying files into the library.

When using Copy Record Link and pasting into a rich text view, the pasted text’s font
will now match that of the surrounding text.

Improved the Next/Previous toolbar buttons.
Dragging from EagleFiler to a burn folder now creates a link instead of copying the file.

If the File column is hidden, both Enter and Option-Enter will bring the Title column
into edit mode.

After you drop a file onto a spring-loaded folder in the source list, EagleFiler will collapse
the temporarily expanded folders.

EagleFiler no longer tries to import SketchUp files as text, and therefore it won’t try to
display them, which led to long freezes as the data overloaded Cocoa’s text system.

Improved capture error messages.

Fixed bug parsing tags from strings containing non-ASCII alphabetic characters.
Fixed bug where labels were lost when editing RTF or RTFD files within EagleFiler.
Now preserves modification dates when capturing from Yojimbo.

If the records list is empty because nothing matched the search, this is now reported in
the viewer so that you don’t wonder why the list is empty.

If Allow Editing in Record Viewer is off, New Rich Text File will now always bring
down a sheet for setting the text of the new file.

Choosing Edit > Find > Library Search... now works when the toolbar is in Text
Only mode.

Fixed help book icon.

1.2.3—July 2, 2007

Calculates folder sizes and shows them in the records list.

Added import plain text AppleScript command for when you want to import a string
as a text file rather than an RTF one.
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e When you view a file, EagleFiler now makes sure that it’s up-to-date in the index, in
case you modified it outside of EagleFiler.

e When you edit a filename in the records list, EagleFiler no longer pre-selects the exten-
sion.

e The Errors window no longer auto-selects errors when they are added.
e Added progress bars when creating or opening a library.

e Rotates the log file to prevent it from growing too large.

e Changed the verification icon.

e Improved error handling when creating or opening a library.

e Fixed bug where folder labels weren’t preserved when importing.

e Worked around OS bug that caused an internal error when pressing Option-Tab in an
empty text view.

e Errors reported from EagleFiler’s lower level frameworks are now reported in the log file
rather than on the system console.

e Fixed bug where EagleFiler would let you import the library into itself.
e Fixed regression where canceling an import sometimes didn’t work.

e Worked around suspected QuickTime bug that caused EagleFiler to not import the
proper ID3 tags from some MP3 files.

e Improved reporting of duplicate file errors.
e No longer tries to import .localized files.
e Fixed bug handling locked files and folders.

e Fixed bug where an error could be reported if you emptied the trash when a record in
it was selected.

e No longer tries to backup the metadata for missing folders.

e Fixed bug displaying e-mail messages when the chosen font was no longer available.
1.2.2—June 20, 2007

e Fixed bug where some menu commands were disabled when the record viewer had focus.

e When you view a PDF file, EagleFiler will now update the page count in the records list
in case it has changed.

e Fixed bug where PDF page counts weren’t transferred when dragging from one library
to another.

e Fixed bug importing text via drag and drop.

e Fixed PyObjC bugs that could cause various crashes and hangs.
e Fixed regression where Open in Delicious didn’t work.

e Fixed icon scaling in Activity viewer when merging mailboxes.

e Fixed regression where where changing Allow Editing in Record Viewer didn’t take effect
immediately.
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Fixed bug where EagleFiler would re-open at launch even libraries that were in the trash.

Worked around Cocoa bug that could cause the record viewer’s scroll bars to be hidden
if you expanded the viewer when the ruler was hidden.

Fixed bug where EagleFiler tried to import invisible metadata files.

Fixed bug where the copy cursor was shown when dragging and dropping within the
record viewer.

Fixed bug where the spell-checking state wasn’t remembered.

Fixed bug with the PDF zoom-to-fit state and the contextual menu.

Worked around PDF Kit bug where the password field wouldn’t disappear.
Fixed bug with To Import folders and locked files.

Fixed bug where EagleFiler let you create a new library on top of an old one.
Fixed bug indexing certain HTML and Microsoft Word files.

Fixed bug with multiple backup metadata operations at once.

1.2.1—June 8, 2007

You can now use the Export... command to export the selected messages in mbox
format, so that they can be imported into any mail program.

The names of To Import folders now include the library name, so that you can tell them
apart in a Finder or open panel sidebar.

Can now capture from Pukka®® and WebKit Nightly?>. When capturing from Yojimbo®,
now preserves the label as an EagleFiler tag. When capturing from Cocoalicious”?,
Journler?®, Yojimbo®, and WebnoteHappy'®’ now preserves the title rather than ex-

tracting it from the file.

The label colors now more closely match those in the Finder, and the pop-up menu sorts
alphabetically.

The tooltip for the Tags column in the records list now shows the names of all the
assigned tags.

Allow duplicate files in library is now a full preference.

When copying tags to Spotlight comments, EagleFiler now separates the tag names with
a space instead of a comma-space, and there is an esoteric preference to set a tag prefix
such as &.

When copying files into the library, now copies the Spotlight comments, too.
Added tooltips to help with setting tag abbreviations in the inspector.

http:
Phttp:
96http:
http:
“nttp:
99http:
100http:

//codesorcery.net/pukka
//nightly.webkit.org

//www .barebones . com/products/yojimbo/
//www.scifihifi.com/cocoalicious/
//www.journler.com

//www .barebones . com/products/yojimbo/
//www.happyapps . com/webnotehappy/
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e The Backup Metadata command can now be used to force EagleFiler to copy the tags
to the Spotlight comments, if you don’t want to wait for this to happen automatically.

o Added esoteric preference to make EagleFiler display Web pages using their print stylesheets.

e When writing a capture script, if you obtain the tag names as a single string, you can
pass it as |tagsString| to let EagleFiler parse it into individual tag names.

e You can now select more than one error at a time in the Errors window.

e Adjusted the word characters used for indexing to make it easier to find words containing
$, @, %, and _. (This will only take effect after rebuilding the indexes.)

e Made some changes to the New Library... interface to make it more clear that the
maximum library size only applies to encrypted libraries.

e Fixed regression where EagleFiler couldn’t open libraries inside folders with non-ASCII
names.

e Fixed regression where the Info inspector sometimes displayed information for the wrong
record(s).

e Fixed bug where .webloc files in the To Import folder were not deleted after importing.

o If EagleFiler encounters an error while importing a file in a To Import folder, it now
moves the file to the Unable to Import folder so that it won’t encounter the same error
again the next time it scans the To Import folder.

e Fixed bug importing WMA URLs.
e Worked around crash due to bug in Search Kit.

e Fixed bug where the records list lost focus when a search was active and you clicked on
a Web archive.

e Fixed bug with the foreground color of highlighted text in the records list.

e Fixed bug where EagleFiler would be slow and could run into an OS error when capturing
a large number of documents at once.

e Made various error reporting improvements.
e Improved undo in the inspectors.
e Fixed cosmetic bug with the Reveal In Library button.

e Fixed interface glitch where it looked as though EagleFiler would let you move the trash
and smart folders around.

e EagleFiler will no longer crash when opening a library on pre-release versions of Mac
OS X 10.5.
1.2—May 30, 2007
e Made a variety of changes to improve EagleFiler’s speed and responsiveness, especially
for libraries with many files.

e You can now copy from one library to another via drag and drop. All of the EagleFiler
metadata will be preserved.

e The New Library... command now offers the option to create an encrypted library.
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e Highlights search matches in the items list and the record viewer.

e Each library now has a To Import folder in the Finder. Any files that you save into this
folder will be imported when you open the library (or within the next minute or two if
the library is already open).

e You can now delete (and undelete) individual e-mail messages.

e Uses the available Spotlight importers to index the content of many types of files that
EagleFiler doesn’t natively understand.

e Added Match Partial Words option to the search pop-up. When this is checked, you
can search for partial words without having to type wildcards (*) in the query.

e tag:<tagname> searches now work with Filename, From, To/Cc, and Title searches,
rather than just Anywhere and Notes searches.

102 (preserving tags).

e Can now capture from Skim'®! and Journler
e When capturing from Cocoalicious'??, EagleFiler now preserves the tags and the de-

scription and extended description.

e Added Backup Metadata command. EagleFiler will automatically backup a library’s
metadata when it’s opened (unless you have Shift held down) and also periodically after
it’s been opened. You can manually backup the metadata by holding down the Option
key and choosing Backup Metadata from the File menu. Metadata is backed up to
EagleFiler Metadata.plist files inside the library folder. If you import a file that has
backed-up metadata, EagleFiler will use the stored metadata to set the title, from name,
checksum, source URL, tags, and notes.

e Added Copy tags to Spotlight comments preference. When this is enabled, you’ll be
able to find files in your library by searching for their tag name using Spotlight.

e If you hold down the Command and Option keys when opening a library, you can access
the new Rebuild Indexes dialog. This lets you optimize or repair EagleFiler’s search
indexes, and you can choose whether it indexes for word searches or phrase searches.
Previous versions of EagleFiler always indexed for phrase searches. Switching to word
indexing will speed up EagleFiler’s indexing and substantially reduce the amount of disk
space that the indexes consume.

e Added Update Checksum command, so that it’s easier to tell EagleFiler when you’ve
modified a file using another application.

e When importing via AppleScript, you can now specify which folder to import into, e.g.
import files {theFile} container theFolder.

e It’s now possible to change filenames via AppleScript.

e When using Previous/Next Record with the Info inspector in front or the tags bar
focused, the text field will retain its focus as the selected record changes, making it
possible to quickly edit multiple tags/titles/filenames in sequence.

e You can now press Option-Delete when viewing a tag source to move the selected records
to the trash rather than unassigning the tag.

Olhttp://skim-app.sourceforge.net
102http: //www. journler.com
103http://www.scifihifi.com/cocoalicious/
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Added Esoteric Preferences.

When exporting messages in .emlx format, now includes the tags and notes.

Now shows a determinant progress bar when importing a folder.

No longer shows a progress window when opening a library.

Improved the display of various kinds of multi-part e-mail messages.

No longer shows the children of smart folders in the source list.

Now shows the pointing hand cursor when you hover over a clickable link in a text view.

From the AppleScript interface, it is now possible to access records by name, subject to
the filename being unique.

Added backup metadata AppleScript command.

You can now change the case of a file’s extension.

Updated to Python 2.5.1.

Worked around OS bug that could cause crash when viewing PDFs.
Fixed bug where the note tag could get out of sync.

Fixed bug where creating a link when editing in a rich text view would sometimes insert
the link after the selected text.

Fixed crash when indexing certain QuickTime files.

Fixed bug calculating checksums of certain document packages.

Fixed memory leak with Activity Viewer window.

Worked around Search Kit bug that could cause a crash when doing a phrase search.

Fixed bug where if you drag-imported multiple folders into a folder, the second and
subsequent folders would be imported at the top level.

Fixed bug capturing from Yojimbo 1.4.2.

Fixed bug where the URL colorer didn’t find certain valid URLs.

Fixed bug where EagleFiler allowed duplicate files to be added to the library.
Fixed threading bugs when importing multiple files at once.

When viewing a Web page, if you click on a link to another part of the same page,
EagleFiler now scrolls the window rather than opening the location in a new window.

Modernized the crash reporter code.

Fixed bug where EagleFiler would sometimes keep files open after a library had been
closed.

Fixed bug where the Info inspector showed “()” for the size of a folder.
Fixed bug in reporting library save errors.

Fixed bug where application-level menu commands could get permanently disabled.

1.1.6—March 5, 2007

Now supports searching by filename.
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Can now capture from Flock!%4,

The interface is a bit more responsive, due to threading improvements when importing,
indexing, and merging.

No longer hangs when indexing a movie with unresolved file references.
No longer uses any CPU time when idle.
Can now import malformed mbox files generated by MailSteward.

Fixed bug where fields in the inspector could lose their focus when a background oper-
ation completed.

Fixed bug dropping onto an item inside the Trash source.
Fixed regression displaying contents of multiple folder sources.
Fixed regression where new rich text records weren’t auto-selected.

Improved error handing during menu/toolbar validation.

1.1.5—February 20, 2007

Worked around a Cocoa bug that could cause a crash when closing a window or open/save
panel.

The Date column is now called Date Modified.
Fixed bug where a record’s cached modified date could get stale.

Fixed bug where closing a window or pulling down the File menu could be slow if there
were messages selected.

Fixed regression where the same mailbox could be indexed by duplicate threads.
Fixed bug remembering the open libraries when quitting.

Fixed display of library names containing slashes.

1.1.4—February 16, 2007

Added Show > Messages in Records Source option. This makes it possible to view and
search everything in the library by selecting the Records source. Previously, to search
e-mail messages you had to select one or more mailboxes; you can still do that, if you
want to restrict the search to just those mailboxes.

The Tags inspector now sorts the assigned tags to the top.

Added Bigger/Smaller commands for adjusting the text size for rich text documents and
Web archives.

You can now omit the Shift key when pressing the keyboard shortcut to zoom in, i.e.
Command-= is now equivalent to Command-+.

Improved URL coloring in messages.

Made various performance improvements, particularly to file indexing, display in the
browser window, and emptying the trash.

04 ttp: //www. £lock. com
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Now shows custom file icons (rather than a generic text icon) for files such as OmniGraffle
documents that are in XML format but are not strictly text documents.

Added New Folder button to the Export. .. dialog.
The Import File(s). .. and Export. .. dialogs are now sheets.
Worked around Search Kit bug that caused crashes when doing phrase searches.

Worked around suspected Cocoa bug that could cause a crash if you pressed Cancel
when creating or opening a library.

Worked around Cocoa bug that could cause the source list not to properly scroll to show
a new tag that had been created.

Fixed bug importing MailTags projects.

Fixed bug where the tags field in the Info inspector didn’t wrap when there were a lot
of tags, or update when the record selection changed.

Fixed bug where insertion point didn’t advance when pressing Space while editing a
tag’s name in the Tags inspector.

Fixed bug accessing tags via AppleScript.

Fixed bug displaying Web archives.

Fixed problem displaying messages in tag sources if an index file had been damaged.
Improved compatibility with pre-release versions of Mac OS X 10.5.

The Software Update auto-updater is now compatible with FileVault.

No longer shows inaccurate size for folders.

Made various improvements to the error reporting and error logging.

1.1.3—January 25, 2007

Can now capture from DEVONagent!%®, DEVONthink Pro!% (preserving comments),

Nisus Writer Express'®”, and Yojimbo!'%® (preserving comments and tags).
Added Copy Source URL to the contextual menu.

Better display of e-mail messages with embedded messages (such as digests and bounced
messages).

You can now use just plain Tab instead of Control-Tab to tab out of the viewer pane in
the browser window when the viewer is a read-only text view.

In the records list, you can now type Option-Enter to edit the title of the selected record.

If a message attachment doesn’t have a name, EagleFiler will list the content subtype
next to the paperclip instead of omitting that attachment.

When capturing from Apple Mail with both messages and mailboxes selected, “Mail-
boxes” is now the default choice.

105http:
106http:
107http:
108http:

//www.devon-technologies.com/products/devonagent/index.html
//www.devon-technologies.com/products/devonthink/index.html

//www.nisus.com/Express/
//www.barebones.com/products/yojimbo/
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e Better error messages when you try to capture a smart mailbox in Apple Mail.

e EagleFiler cannot import mailboxes from Apple Mail on Mac OS X 10.3 and earlier.
Rather than importing the mailboxes as folders, it now reports an error.

e Can now import more types of text clippings.

e Spaces in tag names are now converted to underscores instead of being deleted.

e Fixed error when pressing Enter in the records list.

e Fixed bug where capturing packages from the Finder didn’t work.

e Fixed bug where the scroll position and selection in the notes editor would be messed
up when switching to another application.

e Worked around a Web Kit bug that caused it to needlessly fetch archived portions of a
Web page over the network, or not display them at all if you were offline.

e Worked around a Web Kit bug when displaying a Web archive created from a local
HTML file.

e Fixed bug where Reveal In Library sometimes looked in the wrong library.
e Fixed error undoing in the tags fields.
e Fixed error using the Highlight command with no selection.

e EagleFiler’s helper tools don’t use the URL cache, so now they tell Web Kit not to store
one.

1.1.2—January 9, 2007

e Tabbing between the source list, records list, and viewer works much better, as EagleFiler
now overrides the Cocoa keyboard loop.

e You can now press Enter in the records list to edit the filename or press Return to open
the selected records.

e Can now capture from PDFView!%?.

e AppleScript enhancements:
— Added import text command, which takes a string and creates a new rich text file
in the library.
— You can now access the open browser windows along with their displayed records
and selected records.
— Added note file and trashed properties to library record. Also, various for-
merly read-only library record properties are now writable.

— Added container property to tag.
e If you click the 4+ button in the browser window with the Tags folder or a tag selected,
EagleFiler will create a new tag instead of a new folder.
e EagleFiler is more responsive when emptying the trash, as the lengthy index updating
now takes place in a background thread. Also, EagleFiler now compacts the search index

when emptying the trash, which should reduce the disk space used and speed up future
searches.

109http://pdfview.sourceforge.net
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Added a hidden preference to make EagleFiler not check for duplicate files during im-
porting. Click the link to allow duplicate files or to forbid them.

Worked around PDF kit bug that could cause repeated zooming out when viewing a
PDF.

Fixed bug where EagleFiler didn’t recognize document packages when importing a folder
full of files.

Fixed regression where EagleFiler could freeze when clicking an X button in the Activity
Viewer.

If the library changes while you’re in the middle of editing a table cell or text field, Ea-
gleFiler will no longer replace your in-progress changes with the value from the database,
nor will it mess up the insertion point.

When following an EagleFiler link, if the specified library can’t be found, but one with
the same name is already open, EagleFiler will try to use that library to open the link.

Made various changes to improve the responsiveness of the interface.

Faster file deletions, with better threading, should improve the performance of all back-
ground operations that create temporary files.

Fixed crash when logging indexing errors.
Worked around some framework bugs that could cause a variety of different crashes.
The indexer recovers better when a file is unexpectedly deleted.

Worked around Cocoa bug that could cause some tags to be removed if you ended editing
in a tags field by pressing Return when the insertion point wasn’t at the end of the field.

Fixed regression where changes to the tags weren’t saved when closing the Info inspector.

Text filenames are now allowed to have no text before the extension, so you can now
store and rename “dotfiles” in EagleFiler.

It is now possible to edit the extensions of text files.

If you launch EagleFiler by dropping a file onto it, it will now open the default library
before importing the file rather than complaining that no library is open.

Added blank line before the source URL in the records list tooltip.

No longer brings the Errors window to the front (which was undesirable if you were in
the middle of typing something) when an error occurs—instead, it just makes sure the
window is visible.

7

The mailbox importer now handles messages that start with “>From ” instead of a

header.

Better handling of encrypted PDFs.

Better error reporting in Endo capture script.

Better error message when can’t capture from Mail.
Fixed bug logging errors during mailbox rebuild jobs.

Fixed bug where browser windows didn’t remember whether the trash source was ex-
panded between launches.
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Fixed bug where Command-Right Arrow and Command-Left Arrow didn’t work in text
views.

Fixed bug where Reveal In Library didn’t work for records that were in the trash.

Simplified the Purchase window.

1.1.1—December 18, 2006

When capturing a selection of files from the Finder, Spotlight comments may now be
imported as tags or notes.

Can now capture from Microsoft Excel.

The keyboard shortcut for Import Text is now Command-% instead of Command-<, as
the latter conflicted with a system-wide shortcut when using certain keyboard layouts.

When creating a rich text record using text dragged from Safari (or, generally, any
WebView), EagleFiler will now set the source URL and add it to the bottom of the text.

You can now create records by dragging text selections from within EagleFiler to its
source list or records list.

After you choose Convert For Editing, EagleFiler will now select the newly created RTFD
files rather than leaving the original Web archives selected.

When pasting the results of Copy Source URL into a rich text view, the clickable text
is now the URL itself, rather than the title, and no trailing newline is added.

Added source URL to tooltip in records list.
Generates better titles from dragged text.

If you change the PDF view away from Zoom To Fit, it now remembers the current scale
factor.

Improved the speed of the initial index check when opening the library.
Improved parsing of mbox files.
Fixed bug where capturing some URLs didn’t work.

Fixed bug where, when opening a new window to display a record, the record wasn’t
always selected.

Fixed bug where EagleFiler could hang if you tried to edit the title or filename of a
record while it was doing something else.

Fixed regression where importing via drag and drop from another application sometimes
didn’t work.

Fixed bug and reduced RAM usage when importing a large number of files/folders at
once.

Fixed bug where the source list or records list would go into edit mode when you clicked
on it and it didn’t already have focus.

Fixed bug where a PDF or Web archive would needlessly be scrolled to the first page.
Stopping indexing operations by clicking the X button works better now.

Indexing no longer hangs if there’s a problem loading a Web archive or if it’s corrupt.
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e Worked around OS bug that prevented some Word documents from being indexed.

e Fixed bug reporting errors while adding a file to the library.

e Better error reporting for damaged Web archive files.

e Fixed bug where tag sources showed messages for mailboxes that were in the trash.

e Fixed bug where child tags weren’t sorted in the source list.

e EagleFiler no longer lets you give a tag an empty name.

e Worked around issue when saving libraries on Leopard.

e Worked around OS issue that caused EagleFiler to be the default opener for Word files.

e Worked around some bugs in libraries that EagleFiler uses, which caused errors when
importing text via drag and drop.

e Better error reporting when can’t write a temporary file or save the library.

e The contextual menu now says Delete instead of Move To Trash, since deleting from a
tag source doesn’t move to the trash.

1.1—December 6, 2006

Importing

EagleFiler will now let you import any kind of document. If it doesn’t know how
to display the document, it will simply show the file’s icon, which you can click to
open it in another application.

When importing via drag and drop, you can now drop onto folders or tags in the
source list or into the records list in order to put the imported records into that
folder or assign them that tag.

Now recognizes many more kinds of text files and text clippings.
Can now import individual messages from Entourage via drag and drop.
Added Command-< keyboard shortcut for the Import Text service.

You can now import by control-clicking on a file in the Finder and choosing Open
With > EagleFiler.

Added Import Clipboard command to the Dock menu.
It is now possible to specify tag names and note text when importing via AppleScript.

Capture

Can now capture IMAP mailboxes and individual selected messages from Apple
Mail.

Can now capture from Endo''?, Firefox!!!, and WebnoteHappy!'2.

If you press the capture key when there is no library open or while in an unsupported
application, EagleFiler will now try to help you open a library or import the data
in another way.

Capture scripts can now import tags and notes.

1Ohttp://kula. jp/software/endo/
"ihttp://wuw.mozilla.com/en-US/firefox/
"2http: //www. happyapps . com/webnotehappy/
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Text and Rich Text Files

It’s now possible to edit text, RTF, and RTFD files directly in the record viewer.
EagleFiler will automatically save any changes that you make and update the files’
checksums.

Creating new rich text files is much smoother. The keyboard shortcut is now
Command-N instead of Command-Control-N. If the File column is visible, Eagle-
Filer will bypass the sheet, select the new file in the records list, and bring the File
cell into edit mode so that you can set the filename and title. You can then tab into
the record viewer to begin typing the contents of the file.

You can drag records into the record viewer (or the notes text view) to create links
to them.

Searching

Tags

You can now search by tag. You can also add tag criteria when doing an Anywhere
or Notes search (e.g. tag:apple steve).

Now remembers the last-used search scope (globally and per-window).
You can now access the search syntax help page from the toolbar search field menu.

Added auto-completion when typing tag names.

Added tags field to the bottom of the browser window, so that you can edit the tags
of the selected record without having to open another window. You can quickly give
the tags field keyboard focus by pressing Command-Shift-T.

Tag sources now show all the e-mails with that tag (rather than just the files).
Tag sources now behave more like iTunes playlists and iPhoto albums. If you delete
a record from a tag source, EagleFiler unassigns the tag, but the record remains in
the library.

You can now arrange tags into a hierarchy in the source list, to organize them or to
hide the ones you don’t want to see at the moment.

Added New Tag menu command. If records are selected it changes to New Tag
From Selection and the selected records are assigned the new tag.

Browser Windows

You can now single-click to edit the Title, From, or File directly, instead of having
to open the Inspector window.

Added Convert For Editing command, which lets you convert Web archives to RTFD
files that can be edited.

If you hold down Option when double-clicking a Web archive (or a RTFD file con-
verted from a Web archive), EagleFiler opens the current version of the page rather
than the archive.

EagleFiler now shows custom icons for folders. You can set a custom icon using the
Finder’s Get Info window.

Added Show > Source List and Show > Record Viewer commands for people who
want to use the menu or keyboard instead of double-clicking the divider.
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Added Actual Size and Zoom to Fit commands. The PDF viewer now remembers
its zoom state, so that it won’t keep resetting to Zoom to Fit if you’ve zoomed in.

Remembers the selected sources between launches.
Arrow-keying through the records list is faster now.

Libraries

Added Remember open libraries between launches preference and Startup Items
folder.

The Drop Pad now has commands for creating a new library, opening a library, and
opening recent libraries.

The Dock menu now shows recent libraries.

Other Enhancements

If you ask EagleFiler to import a URL and the URL can’t be saved as a Web archive
(e.g. because it’s an image or PDF), EagleFiler will download the file and import it

as-is, rather than reporting an error about not being able to save a Web archive.

113

Now imports MailTags *® projects as tags.

The Zoom In and Zoom Out commands now work with Web archives, where they
change the font size.

The Copy URL command is now called Copy Record Link.

Added Highlight command, which changes the background of the selected text to
yellow.

Added Outline and Styles. .. to the Format menu.

Dragging a library file onto the Drop Pad now opens the library rather than com-
plaining that the library can’t be imported.

Improved the way EagleFiler auto-generates file names when creating a file from
dragged text or a Web page’s title.

Now skips importing Apple Mail messages that are marked as deleted.

Capture scripts are now allowed to use the compiled script format, with the .scpt
extension.

Folders and mailboxes no longer have a title attribute that’s separate from the file
name.

When creating a new rich text file inside a sub-folder, it’s now revealed there instead
of in the Records source.

Indexing is now somewhat faster and uses less memory.
Double-clicking a folder now opens it in EagleFiler instead of in the Finder.

In the source list, single-clicking now enters edit mode and double-clicking now opens
the source.

Improved secondary sorting of records list.
Increased maximum width of the Kind column.
Added keyboard shortcuts for Select Source and Hide Others.

"3http://www.indev.ca/MailTags . html
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Rich text copied using Copy Record Link now includes the title of the record, rather
than just the URL.

Now displays the proper background color for RTF documents.

Added Open Source URL, Copy Record Link, and Verify to the contextual menu.
The underscore and hyphen characters are now allowed in tag names.

You can now drag into the records list of a tag source to assign that tag.
Shortened toolbar button labels.

The menu commands for Show Inspector and Show Tags now toggle the visibility
of the windows rather than showing them.

The Software Update checker now works behind an HTTP proxy.

The Import Files menu command no longer allows you to import individual files
inside an Apple Mail mailbox, as this is usually an error.

Moved Open in External Viewer command to the Record menu.
Added keyboard shortcut for Open Source URL.

Reordered Record menu.

Reduced number of threads used on single-core Macs.

You can now delete tags from the source list.

Bug Fixes

Periods in the names of folders are now treated as part of the name, rather than as
the beginning of a path extension.

Worked around OS bug that prevented phrase searching from working. Because of
this, EagleFiler will automatically rebuild the indexes of any opened libraries.

Fixed bug that could cause a crash when importing large folder hierarchies.

When importing a folder, EagleFiler will now ignore any invisible Find By Content
index files.

Fixed bug importing and moving files with very long names.
Fixed bug in .emlx exporter.

Fixed bug where EagleFiler couldn’t import a Web page if WebKit crashed while
trying to extract its text.

Fixed bug with using Capture command in Dock menu.

Fixed bug where EagleFiler didn’t let you capture if you launched it by opening a
library from the Finder and then switched to another application so that it finished
launching in the background.

The capture key is now ignored if EagleFiler is frontmost.

Fixed spelling and resizing of “Title” label in the New Rich Text File sheet.
Fixed crash that could occur when indexing.

Fixed bug where an indexing operation could stall indefinitely.

If a document or message can’t be indexed, EagleFiler is better at continuing on
and indexing the rest of the documents or messages.

Better logging of index problems.
Fixed bug where indexed searching didn’t work in tag sources.
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e Fixed bug where undo didn’t work after renaming in source list.

e Fixed bug where the user could use drag and drop to change the page that the Web
view was displaying to one other than that of the selected Web archive.

e Better display of messages with no text parts.

e Fixed bug where the Recent smart folders didn’t show records that were inside
folders.

e Fixed bug where Web archives couldn’t be displayed, depending on if you had certain
preferences set in Safari.

e Fixed bug where the selection in the notes text view would be needlessly reset when
the library changed.

e Fixed bug that could lead to error when undoing too far in the notes text view.

e No longer allows you to give a file an empty name (before the extension), as this
confuses Cocoa.

e Fixed bug where the Show Inspector command opened the inspector but didn’t
give it keyboard focus.

e Worked around OS bug that could cause crash when using NetNewsWire Lite.

e Fixed a few bugs that made it impossible to launch EagleFiler from a path containing
non-ASCII characters.

e Fixed small memory leak when processing errors.

e Fixed bug where you couldn’t create a new folder with / in the name.

e Fixed bug where showed : instead of / when displaying file names.

e The file system encoding is no longer hard-coded to UTF-8.

e Improved thread-safety of record properties.

e When launching, no longer prints “CMSCreateDataProviderOrGetlnfo : Invalid
colorspace type” message to console.

e Fixed bug where changes to a file’s name or title weren’t always propagated to the
index.

e Fixed bug where source URLs weren’t being cached properly.

e Fixed bug opening aliases of libraries.

e Fixed bug where you couldn’t create or open a library if its path contained non-
ASCII characters.

e Worked around bug in SOHO Notes (and other applications) that prevented drag-

and-drop importing of promised files from working.
e Fixed bug importing notes from MailTags' .
e Fixed bug where the drag image for a selected source used white text.

e Fixed bug where displaying an HT'ML e-mail message would take too long to time-
out.

e Fixed bug in reporting HTML rendering errors.
e Fixed internal error when closing a library right after opening it.

e Improved error recovery when an untrusted server certificate is encountered while
creating a Web archive.

Uihttp://www.indev.ca/MailTags . html
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1.0.2—October 14, 2006

e Fixed bug capturing from Apple Mail.
1.0.1—October 14, 2006

e Fixed problem where EagleFiler would sometimes crash at launch if an input manager
or haxie was installed.

e Worked around OS bug that caused jitter in the software update progress bar.

e The software update installer no longer says it failed if it succeeded.

1.0—October 13, 2006

e First public release.
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